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Preface
Use this guide to assist you while navigating PowerSchool. This guide is based on the
PowerSchool online help, which you can also use to learn the PowerSchool Student
Information System (SIS) and to serve as a reference.
The PowerSchool online help is updated as PowerSchool is updated. Not all versions of the
PowerSchool online help are available in a printable guide. For the most up-to-date
information, click Help on any page in PowerSchool.

Referenced Sections
This guide is based on the PowerSchool online help, and may include references to
sections that are not contained within the guide. See the PowerSchool online help for the
referenced section.

Security Permissions
Depending on your security permissions, only certain procedures may be available to you.

Navigation
This guide uses the > symbol to move down a menu path. If instructed to “Click File > New
> Window,” begin by clicking File on the menu bar. Then, click New and Window. The
option noted after the > symbol will always be on the menu that results from your previous
selection.

Notes
It is easy to identify notes because they are prefaced by the text “Note:.”

Preface
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Introduction
Use PowerSchool's import functions to submit large amounts of information into the
system. Use the export functions to retrieve large amounts of information from the system.
Before importing or exporting, keep the following concepts in mind.

Importing Menu
The Importing Menu includes the following information:
Field

Quick Import

Quick Import for
State-Specific
Extended Tables

Import Using
Template

Templates for
Importing

Introduction

Description
Click to import records from an ASCII text file. For more
information, see Quick Import.
Note: The Quick Import page is now also accessible via Start >
System > Page and Data Management > Quick Import.
Click to import records from an ASCII text file. For more
information, see Quick Import for State-Specific Extended Tables.
Note: The Quick Import for State-Specific Extended Tables page is
now also accessible via Start > System > Page and Data
Management > Quick Import for State-Specific Extended
Tables.
Click to import records from an ASCII text file using an import
template for Student, Staff, and Course records. For more
information, see Import Using Template.
Note: The Import Using Template page is now also accessible via
Start > System > Page and Data Management > Import Using
Template.
Click to configure import mapping templates for common imports
into Student, Staff, and Course records. For more information, see
Templates for Importing.
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Note: The Templates for Importing page is now also accessible via
Start > System > Page and Data Management > Templates for
Importing.

Data Import
Manager

Click to access the import manager. For more information, see
Data Import Manager.
Note: The Data Import Manager page is now also accessible via
Start > System > Page and Data Management > Data Import
Manager.
Click to view in progress and completed imports. For more
information, see Data Import Queue.

Data Import Queue

Note: The Data Import Queue page is now also accessible via
Start > System > Page and Data Management > Data Import
Queue.

Exporting Menu
The Exporting Menu includes the following information:
Field

Quick Export

Export Using
Template

Templates for
Exporting

Introduction

Description
Click to export student data. For more information, see Quick
Export.
Note: The Quick Export page is now also accessible via Start >
System > Page and Data Management > Quick Export.
Click to export using an existing template. For more information,
see Export Using Template.
Note: The Export Using Template page is now also accessible via
Start > System > Page and Data Management > Export Using
Template.
Click to set up export templates. For more information, see
Templates for Exporting.
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Note: The Templates for Exporting page is now also accessible via
Start > System > Page and Data Management > Templates for
Exporting.

Data Export
Manager

Click to access the export manager. For more information, see
Data Export Manager.
Note: The Data Export Manager page is now also accessible via
Start > System > Page and Data Management > Data Export
Manager.

Select a Group
Before you can import or export, you must select a group of students whose records you
want to review. For more information, see Student Search.

Importing Enrollment Dates
You can import student information into PowerSchool using Quick Import or AutoComm.
When you import a student record that has an enrollment date prior to or "less than" the
current date, the student record is considered "historical." Historical student records are
considered inactive students. Therefore, when searching for such students, your search
criteria must start with a slash ("/") to search all student records.

Importing Enrollment IDs
Basics






If the EnrollmentID column (Students table) or ID column (ReEnrollments table) is
not included in the import, PowerSchool retains the existing value (on an update to
a Students table record) or generates a new unique value.
If the EnrollmentID column (Students table) or ID column (ReEnrollments table) is
included in the import with data (values), PowerSchool uses the imported value,
assuming it is not already in use by another enrollment. If it is in use, an error
message indicating such displays.
If the EnrollmentID column (Students table) or ID column (ReEnrollments table) is
included in the import without data (values), PowerSchool generates a new value,
even if one already exists. In general, this is not recommended, as existing
information may be used for state reporting.

Introduction
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The Students table allows for updating of records, whereas the ReEnrollments table
does not.

Students Table








In general, it is recommended to not include the EnrollmentID column when
importing into the Students table. When the EnrollmentID column is not included,
PowerSchool automatically determines if an EnrollmentID value already exists. If
one exists, the value is retained. If one does not exist, a value is generated.
Only under certain circumstances it is recommended to include the EnrollmentID
column when importing into the Students table. For example, if a Student record
has been deleted and needs to be restored from a test or backup server, including
the EnrollmentID column would restore the EnrollmentID value back to what it was
prior to the deletion of the record (unless the EnrollmentID was different on the test
or backup server, in which case it is recommended to not include the EnrollmentID
and let PowerSchool generate one). Note that this is just one example where it is
recommended to include the EnrollmentID column when importing into the
Students table.
Importing an EnrollmentID column that does not contain data (or contains values of
zero) causes EnrollmentIDs to be regenerated for all the imported records,
regardless of whether or not an Enrollment ID exists for the record. In general,
including the EnrollmentID column without values (or with values of zero) is not
recommended.
If importing new students, you do not need to include the EnrollmentID column.
PowerSchool generates a value during the import.

ReEnrollments Table







The ReEnrollments table does not allow for updating of records. Therefore, to
“update” a record, first export the existing data (including the ID field), delete the
existing record and then re-import the record with the updated data. When reimporting, include the ID column with the exported values so that the ID will not be
regenerated.
If the ID is left blank or if the ID column is not included, a new ID is generated. In
general, this is not recommended as existing information may be used for state
reporting.
“Updating” should be done with caution. It is recommended you perform the update
on a test or backup server first prior to performing on a production server.
If importing new reenrollments, you do not need to include the ID column.
PowerSchool generates a value during the import.

Introduction
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Student Number Field
The student number field is essential to moving all of the data in PowerSchool. This field
matches student data to the correct student with absolute certainty. Each student has only
one number, and everything in PowerSchool is linked to this number. Thus, you should
include the student_number field in all documents that you export. You must include the
student number in any document that includes data you want to import into PowerSchool.
Keep this in mind when exporting, especially if you want to import the data back into
PowerSchool after you have worked with it in your spreadsheet application.

Enroll Status Field
The enroll status field indicates a student's current enrollment status, which defines the
student's entire basis in school. Enroll status codes include:









-2 or less = Inactive (Must be set manually by an administrator)
-1 = Pre-registered
0 = Active
1 = Inactive (Must be set manually by an administrator)
2 = Transferred-Out
3 = Graduated Students (Students moved to the "Graduated Students" school.)
4 = Imported as Historical
5 or higher = Inactive (Must be set manually by an administrator)

More often than not, the only time you will see this code is if you are working within the
database. However, you may encounter the code within the student pages of the
application for students with an enroll status other than Active, such as Inactive, Graduated
Students, or Imported as Historical. In this case, the code appears at the top of the page.
This field is used throughout the application and is a key element in searching or querying
students.

Field Names
It is important to spell field names correctly. Case sensitivity is unimportant in field names,
but spelling must be exactly as noted on the field list. If you omit the underscore, misspell
words, or enter a field name that is different from what exists in the field list, PowerSchool
cannot find the field and it will not be imported into or exported from the PowerSchool
database. If you do not know how a specific field name is written, click View Field List on
the PowerSchool start page.

Introduction

10J

Import and Export User Guide

Special Export Codes
Use special export codes to include a student's GPA or other calculated value in your
import or export. For more information about data codes, see PowerSchool Data Codes. You
will need your username and password to sign in. If you do not have this information,
contact your System Administrator.

Data Versus Reports
Importing or exporting data is different than importing or exporting report templates.
When you import or export data, you move information between a spreadsheet application
and your PowerSchool database. When importing or exporting a report template, you are
copying report parameters from one PowerSchool system to another PowerSchool system.
For more information about importing and exporting report templates, see Alternate Ways
to Create Reports and Report Templates.

SIS Views
SIS Views provide quick access to key metrics and not just raw data. These pre-defined SQL
queries extract data that can be joined together and filtered to provide customized results.
For detailed information, see the Data Dictionary SIS Views available on PowerSource.

Introduction
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Import
Quick Import
Use the Quick Import function to bring a large amount of data into PowerSchool. Before
completing this procedure, you must have an ASCII text file that contains the data to import
and is preferably delimited by tabs.
For information about importing test results, see How to Import PowerSchool Test Scores.
Database Extensions and Quick Import
Database extension fields appear while mapping fields from an import file to PowerSchool.
When importing and mapping these fields, keep the following in mind:







As import/export reads from and writes to a text file, binary data is not supported.
PowerSchool assumes a user only imports data that was exported, therefore it is
also assumed that date formats and any other formats do not need to be errorchecked on import. The date format used is mm/dd/yyyy.
Delimiters occurring in the data are not escaped (for example, fields are delimited
by tabs, but one field contains tabs) and can cause problems when importing. Data
can be wrapped with double quotes to lessen the issue, but there is still data (ex.
double quote + tab + double quote) that can cause the same problems.
Boolean values will be case insensitive, "true/false" or "t/f" or 1/0.

How to Import Data Using Quick Import
Note: Verify that you are signed in to the appropriate school. If the school is incorrect, click
School at the top of the page to choose a new school before starting this procedure.
Note: The Quick Import page is now also accessible via Start > System > Page and Data
Management > Quick Import.
1. On the start page, choose Special Functions under Functions in the main menu.
The Special Functions page appears.
2. Click Importing & Exporting. The Importing & Exporting page appears.
3. Click Quick Import. The Quick Import page appears.
4. Use the following table to enter information in the fields:

Import
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Field

Description
Choose the table to which the data will be imported from the popup menu:



If you choose the Students table, be sure to import at least
20 student records.
If you choose the Sections table, be sure the target term is
selected. For more information, see How to Change Terms.
Note: When importing multiple section records, the
expressions of the sections defined by your school
are required. An expression is the combination of
the periods and days in which the section meets.
Though PowerSchool creates internal values for
periods and days, you should import the actual
values that you want to appear when the system
displays expressions. An invalid expression causes
an error for that record, which results in the record
not being imported.

Table


If you choose the Student Schedules (CC table), be sure to
include data in the import file for the following required
fields:
 Student_Number
 Course Number
 Section Number
 DateEnrolled
 Dateleft
 TermID
 SchoolID
 Term_Number
Note: If you include the Dropped column in your import
file, any record with a value of True will be imported as a
dropped enrollment.



Import

If you attempt to choose the Courses table, but it does not
appear in the pop-up menu, then the district may only
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allow new courses to be created at the district office. For
more information, see How to Edit Course Settings.

Choose the field delimiter from the pop-up menu. This refers to
the item that will separate the fields in the exported data.
Field Delimiter




Tab: Separates fields with a tab
Other: Enter a field delimiter in the blank field, such as a
comma

Choose the end-of-line marker from the pop-up menu. This refers
to the item that will separate the records in the exported data.
End-of-Line Marker






CR: Carriage return
CRLF: Carriage return line feed
LF: Line feed
Other: Enter a delimiter in the blank field

Use the pop-up menu to choose the character set for the import
file. This selection is specific to the operating system where the
import file was created:
Character Set





Windows ANSI (Windows)
Mac Roman (Mac)
ISO 8859-1 (Unix)

File to Import

Enter the file path and name of the file to import or click Choose
File (or Browse), navigate to the data file, and click Open.

Suggest Field Map

Select the checkbox to have the system suggest into which
PowerSchool field each piece of data in the data file is saved.
These are just suggestions and can be changed before saving.

School

The name of the school for which you are importing data.

5. Click Import. The Import Records from an ASCII Text File page appears.
Import
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Note: When importing test results, the Select Test page appears instead. For more
information, see How to Import PowerSchool Test Scores.
6. Use the following table to enter information in the fields:
Field

Description

From Your File

The fields of the first record from the import file appear.
If you select the Suggest field map checkbox on the Quick Import
page, the PowerSchool fields suggested for each piece of data
imported appear.

To PowerSchool

If you do not select the Suggest field map checkbox or you need
to change the fields, use the pop-up menu to choose the
PowerSchool field into which the system imports the data from
the import file.
Do one of the following:

Check to exclude
first row

The lines below can
be used to assign a
constant value to
field(s) in all of the
imported records.




Select the checkbox to prevent importing the header row.
Deselect the checkbox to import the first row. This should
be used if your import file does not contain a header row.

To enter a new value in a PowerSchool field for all records from
the import file, such as entering the same city for all student
records in an import file:
1. Enter the value you want to import for all records.
2. Use the pop-up menu to choose the PowerSchool field into
which the system imports the value.

7. Use the following table to enter information in the Advanced Import Options fields:
Note: Advanced Import Options appear based on the table that was selected from
the Table pop-up menu.
Table
Import

Description
15J
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Attendance

Select the Overwrite existing attendance with the imported
attendance checkbox if you want the system to use the imported
attendance data in cases where attendance codes already exist
for that day or class.

Comment Bank

Select the Update comment bank records checkbox if you want
the system to use the imported comment bank comments in
cases where there are already comment bank comments with the
same code.

Courses

Select the Update course records checkbox if you want the
system to add course-related information to existing course
records in cases where the course numbers are the same.
Do the following:




Historical Grades



If you want the system to include more than one score for
a student only when the term and storecode are the same,
select the Allow multiple grades for a student to be
stored checkbox.
If the courses in the import file have unrecognized names
and you want to specify the course number range for the
imported courses, select the If a course name is
imported that is not recognized checkbox and enter the
range for the new course numbers in the range fields. If
you do not select the checkbox, the system will assign a
random course number in the 9000 range.
To store grades that include neither a letter grade nor any
earned credit, select the Allow grades to be stored which
contain both checkbox.

Do the following:


Immunizations


Import

If you do not want the system to import immunization data
that already exists for a student, select the Where values
exist in the import file and in PowerSchool, DO NOT
IMPORT the values option.
If you do want the system to import immunization data
that already exists for a student, select the Where values
16J
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exist in the import file and in PowerSchool, OVERWRITE
the values in PowerSchool with the values in the
import file option.

Meal Transactions

Select the Use PowerSchool's internal student id numbers
checkbox if you want the system to reference the ID field versus
the student_number field.
Do the following:


Sections



Select the Update section records checkbox if you want
the system to add section-related information to existing
section records in cases where the course and section
numbers are the same.
If your school uses AutoComm to synchronize your data in
PowerSchool with data in another system, select the
Synchronize Mode checkbox to perform an AutoComm
import. Check with your PowerSchool administrator before
using this option.

Select one of the following options to determine what you want
the system to do when a student record in the import file contains
a student ID number that already exists in PowerSchool:




Students


Import

If you do not want the system to import any record with a
student number that already exists, select Do not process
that line from the file being imported.
If you want the system to update the matching student's
record with the data in the import file, select Update the
student's record with the information from the file
being imported.
If you want the system to create a new record if a student
ID number is in the import file, select Generate a new,
unique student number for the student (from the
range specified below). Then, select the checkbox below
this option and enter the number range within which you
want the system to generate and assign the new student
ID numbers.
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If your school uses AutoComm to synchronize your data in
PowerSchool with data in another system, select the
Synchronize Mode checkbox to perform an AutoComm
import. Check with your PowerSchool administrator before
using this option. It is a system requirement that you must
import at least 20 student records.

Do the following:


Select Normal Mode to import records for the active
terms of the current school.
Note: If no SchoolID is included in the import file,
the system defaults to this mode.



Student Schedules

Select Synchronize Mode if your school uses AutoComm
to synchronize your data in PowerSchool with data in
another system. When selected, all other Advanced Import
Options are unavailable and the system defaults to Normal
Mode.
Synchronize Mode drops existing section
enrollments and imports new enrollments from
your import file. For example, if a student is
currently enrolled in English during second period
and the import file contains a record for that
student for Science second period, the system will
drop the student’s section enrollment for English
and import the Science section enrollment.
Note: This change cannot be undone.
If course and section numbers are shared across
multiple schools, it is recommended that you
include the SchoolID in the import file. If course and
section numbers are shared across multiple schools
and the SchoolID is not included in the import file,
the system will not import the records, and the
following alert appears, "Not Imported: The import
school: ( ) does not match the current school.
Skipping Record."

Import
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Warning: Check with your PowerSchool
administrator before using this option.


Select Historical Mode to import records for any term for
the current school.
Note: This option is not available unless the import
files include SchoolID data.



Select District Mode to import records for active terms at
any school.
Note: This option is only available when signed in to
the district office.



Select Historical and District Modes to import records for
any terms at any school.
Note: This option is only available when signed in to
the district office.

Teachers

Select the Update teacher records checkbox if you want the
system to add teacher-related information to existing teacher
records in cases where the teacher numbers are the same.

Test Scores

For information about importing test results, see How to Import
PowerSchool Test Scores.

8. Click Import. The Importing [File to Import] page displays the processed records. If
a record could not be imported due to an error, the row number of the record along
with the reason it could not be imported appears. If a record was successfully
imported, the row number of the record along with the action taken appears.

Quick Import for State-Specific Extended Tables
Use the Quick Import for State-Specific Extended Tables function to bring a large amount of
data into PowerSchool state-specific extended tables. Before completing this procedure,
you must have an ASCII text file that contains the data to import and is preferably delimited
by tabs.

Import
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How to Import Data Using Quick Import for State-Specific Extended Tables
Note: Verify that you are signed in to the appropriate school. If the school is incorrect, click
School at the top of the page to choose a new school before starting this procedure.
Note: The Quick Import for State-Specific Extended Tables page is now also accessible via
Start > System > Page and Data Management > Quick Import for State-Specific
Extended Tables.
1. On the start page, choose Special Functions under Functions in the main menu.
The Special Functions page appears.
2. Click Importing & Exporting. The Importing & Exporting page appears.
3. Click Quick Import for State-Specific Extended Tables. The Quick Import for
State-Specific Extended Tables page appears.
4. Use the following table to enter information in the fields:
Field

Description

Table

Choose the extended table to which the data will be imported
from the pop-up menu.
Choose the field delimiter from the pop-up menu. This refers to
the item that will separate the fields in the exported data.

Field Delimiter




Tab: Separates fields with a tab
Other: Enter a field delimiter in the blank field, such as a
comma

Choose the end-of-line marker from the pop-up menu. This refers
to the item that will separate the records in the exported data.
End-of-Line Marker

Character Set

Import






CR: Carriage return
CRLF: Carriage return line feed
LF: Line feed
Other: Enter a delimiter in the blank field

Use the pop-up menu to choose the character set for the import
file. This selection is specific to the operating system where the
import file was created:
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Windows ANSI (Windows)
Mac Roman (Mac)
ISO 8859-1 (Unix)

File to Import

Enter the file path and name of the file to import or click Choose
File (or Browse), navigate to the data file, and click Open.

Suggest Field Map

Select the checkbox to have the system suggest into which
PowerSchool field each piece of data in the data file is saved.
These are just suggestions and can be changed before saving.

School

The name of the school for which you are importing data.

5. Click Import. The Import Records into an Extended Table from an ASCII Text File
page appears.
6. Use the following table to enter information in the fields:
Field

Description

From Your File

The fields of the first record from the import file appear.
If you select the Suggest field map checkbox on the Quick Import
page, the PowerSchool fields suggested for each piece of data
imported appear.

To

If you do not select the Suggest field map checkbox or you need
to change the fields, use the pop-up menu to choose the
PowerSchool field into which the system imports the data from
the import file.
Do one of the following:

Check to exclude
first row

Import




Select the checkbox to prevent importing the header row.
Deselect the checkbox to import the first row. This should
be used if your import file does not contain a header row.
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Do one of the following:
Update Existing
Rows

The lines below can
be used to assign a
constant value to
field(s) in all of the
imported records.




Select the checkbox if you want the system to update
existing rows with data from each import.
Deselect the checkbox if you do not want the system to
update any row that contains data.

To enter a new value in a PowerSchool field for all records from
the import file, such as entering the same city for all student
records in an import file:
1. Enter the value you want to import for all records.
2. Use the pop-up menu to choose the PowerSchool field into
which the system imports the value.

7. Enter information in the Advanced Import Options fields.
Note: Advanced Import Options appear based on the table that was selected from
the Table pop-up menu.
8. Click Submit. The Importing [File to Import] page displays the processed records. If
a record could not be imported due to an error, the row number of the record along
with the reason it could not be imported appears. If a record was successfully
imported, the row number of the record along with the action taken appears.

Templates for Importing
If you often import the same fields of data, you can create a template so that you don't
have to define the import parameters and field import map every time you perform an
import.
For example, if you often import an update from the school nurse with immunization
information, create a template that includes the fields and format for immunization-related
fields.
Database Extensions and Import Templates
You can specify any database extension fields on the template.

Import
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Delimiters occurring in the data are not escaped (for example, fields are delimited
by tabs, but one field contains tabs) and can cause problems when importing. Data
can be wrapped with double quotes to lessen the issue, but there is still data (ex.
double quote + tab + double quote) that can cause the same problems.
Boolean values will be case insensitive, "true/false" or "t/f" or 1/0.

How to Add an Import Template
Create an import template to use each time you import the same data into your
PowerSchool system.
Note: The Templates for Importing page is now also accessible via Start > System > Page
and Data Management > Templates for Importing.
1. On the start page, choose Special Functions under Functions in the main menu.
The Special Functions page appears.
2. Click Importing & Exporting. The Importing & Exporting page appears.
3. Click Templates for Importing. The Templates for Importing page appears.
4. Click New. The New Import Template page appears.
5. Use the following table to enter information in the fields:
Field

Description

Name of this
template

Enter a name for the template.

Import into this
table

Choose the Students, Courses, or Teachers table from the popup menu.
Note: If Courses does not appear in the pop-up menu, then the
district may only allow new courses to be created at the district
office. For more information, see How to Edit Course Settings.

Delimited or fixedlength?

Choose Delimited or Fixed-field length for the data format from
the pop-up menu.

Field delimiter

If you chose Delimited, choose which delimiter to use to separate
the fields in the exported data from the pop-up menu:


Import

Tab
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Comma
Other: Enter the type of field delimiter in the adjacent
field.

Choose one of the following to determine how the records are
separated in the files you import using this template from the
pop-up menu:
End-of-line (record)
delimiter

Update Mode






CR: Carriage return
CRLF: Carriage return/line feed
LF: Line feed
Other: Enter the type of end-of-line delimiter in the
adjacent field, such as a semicolon.

Select the checkbox if you want the data in the file you import to
update any fields with existing data. Otherwise, deselect the
checkbox.
Create a map to determine into which PowerSchool fields each
field of information in the import file is saved. Enter the fields in
the order they appear in the import file.

Columns

If you chose Fixed-field length, indicate the width of each column
(in characters) and the field name. To separate the number and
field name, enter <tab>. For example, if the first column in your
fixed width file contains the student's phone number, enter
12<tab>home_phone.
If you chose Delimited, enter each field name and press RETURN
(Mac) or ENTER (Windows).
If you are adding columns for database extensions, enter the
extension field name using the format [extension
name].[fieldname].

6. Click Submit. The Templates for Importing page displays the new template.

Import
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How to Edit an Import Template
Edit an import template to use each time you import the same data into your PowerSchool
system.
Note: The Templates for Importing page is now also accessible via Start > System > Page
and Data Management > Templates for Importing.
1. On the start page, choose Special Functions under Functions in the main menu.
The Special Functions page appears.
2. Click Importing & Exporting. The Importing & Exporting page appears.
3. Click Templates for Importing. The Templates for Importing page appears.
4. Click the name of the template you want to edit. The Edit Import Template page
appears.
5. Edit the information as needed. For field descriptions, see How to Add an Import
Template.
6. Click Submit. The Templates for Importing page displays the edited template.

How to Delete an Import Template
Delete import templates when they are no longer needed to conserve space on your
system and minimize the possibility of confusion with the templates that are still used.
Note: The Templates for Importing page is now also accessible via Start > System > Page
and Data Management > Templates for Importing.
1. On the start page, choose Special Functions under Functions in the main menu.
The Special Functions page appears.
2. Click Importing & Exporting. The Importing & Exporting page appears.
3. Click Templates for Importing. The Templates for Importing page appears.
4. Click the name of the template you want to delete. The Edit Import Template page
appears.
5. Click Delete.
6. Click Confirm Delete. The Selection Deleted page appears.

How to Import Using a Template
When importing data using a template, you match the data with the fields defined in the
template. To complete this procedure, you need a data file saved to a local or network
location and an import template. For more information about creating an import template,
see How to Add an Import Template.
Note: The Import Using Template page is now also accessible via Start > System > Page
and Data Management > Import Using Template.
Import
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1. On the start page, choose Special Functions under Functions in the main menu.
The Special Functions page appears.
2. Click Importing & Exporting. The Importing & Exporting page appears.
3. Click Import Using Template. The Import Using Template page appears.
4. Use the following table to enter information in the fields:
Field

Description
Choose the template to use from the pop-up menu.

Import template

File to import

Note: Click template to link to the Templates for Importing page,
where you can view, create, edit, and remove templates used for
importing.
Either enter the data file path and name in the field, or click
Browse... to select the data file.

5. Click Submit. The Import Check: [data file name] page appears.
6. Verify that the data correlates to the fields from the template. If it doesn't, click the
link to modify the template. For more information, see How to Edit an Import
Template. Otherwise, click Import. The Importing: [data file name] page appears,
and the data is imported.

How to Export a Template
Export a template used for importing data to save a backup copy of the template. Though
you can view and modify the exported template using an application such as a Web
browser, the exported template can also be sent to a system outside of your PowerSchool
system.
Note: The Templates for Importing page is now also accessible via Start > System > Page
and Data Management > Templates for Importing.
1. On the start page, choose Special Functions under Functions in the main menu.
The Special Functions page appears.
2. Click Importing & Exporting. The Importing & Exporting page appears.
3. Click Templates for Importing. The Templates for Importing page appears.
4. Click the name of the template to be exported in the Template Name column. The
Edit Import Template page appears.
5. Click Export this template. The File Download dialog appears.
6. Select Save File As... or Save this file to disk. The Save or Save As dialog appears.
Import
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7. Select a file location.
8. Click Save. The template saves to the selected location.

AutoComm Setup
Use AutoComm to synchronize the data in PowerSchool with that in another system, such
as a mainframe system. To synchronize your data, set up intervals at which PowerSchool
automatically imports files of data from the other system.
To use AutoComm, create an AutoComm record where you determine the synchronization
parameters for each of the following files:






Courses
Teachers
Sections
Students
Student schedules

Note: When importing multiple section records, the sections' expressions as defined by
your school are required. An expression is the combination of the periods and days in
which the section meets. Though PowerSchool creates internal values for periods and days,
you should import the actual values that you want to appear when the system displays
expressions. An invalid expression causes an error for that record, which results in the
record not being imported.

How to Add an AutoComm Record
PowerSchool uses the parameters that you define for the record on this page to import the
appropriate data at the dates and times you specify.
1. On the start page, choose System under Setup in the main menu. The System
Administrator page appears.
2. Under Data Management, click AutoComm Setup. The AutoComm Setup page
appears.
3. Click New. The AutoComm Record page appears.
4. Use the following table to enter information in the fields:
Field

Description

Name

Enter the name of this record.

Import
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Use the pop-up menu to choose the table into which you are
importing data with this record:

Table to Import








Attendance
Students
Courses
Sections
Student schedules
Teachers

Note: The Attendance Recording Methods choices made on the
Attendance Preferences page affect the Attendance table options.
Use the pop-up menus to determine the hour and minutes at
which you want PowerSchool to automatically import data.
When to Execute

Days to Execute

Note: If the minutes are 00, AutoComm will run after the Hourly
Process has completed—not specifically on the hour stated, but
within that hour.
Enter the days of the week you want the system to import
records. Starting with Monday, use the following abbreviations for
the days of the week: MTWHFSU.
Do one of the following:

Turn Execution Off




Select the checkbox to stop the system from automatically
importing data.
Deselect the checkbox to turn AutoComm on.

Indicate the method by which you want to import the records
from the other system from the pop-up menu.

Send Output to

To use a local (or network shared file system) to import the
records from the other system:
1. Choose Local (or network shared) File System.
To use the file transfer protocol (FTP) to import the records from
the other system:

Import
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1. Choose Ad Hoc FTP Server.
2. Enter information in the following fields:
 Use Passive Mode - If your FTP has difficulty
transferring, select the checkbox.
 FTP host name
 FTP account name
 FTP password
 Timeout in seconds - Indicates the number of
second that PowerSchool will try to make the initial
FTP connection with the remote system.
To use a managed connection, such as SFTP, to import the
records from the other system:
1. Choose Managed Connection. A second pop-up menu
appears.
2. Choose a managed connection from the pop-up menu.
Note: Managed Connections only appears in the pop-up if
configured and download capability is enabled. See
System > System Settings > Plugin Management >
Remote Connection Manager.
Enter the path to the folder of the file on your computer or
network.
Path

If using PowerSchool on a single node, the path needs to be
defined as being from the root; if using a server array, only the file
name should be used and never the path, since there is only one
location for AutoComm files to be located on a server array.
Use the pop-up menu to choose one of the following to determine
how values are separated in the import file:

Field Delimiter

Import




Tab
Comma
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Use the pop-up menu to choose how records are separated in the
import file. This selection is specific to the operating system
where the import file was created:
Record Delimiter





CRLF: Carriage return, line feed (Windows)
CR: Carriage return (Mac)
LF: Line feed (Unix)

Use the pop-up menu to choose the character set for the import
file. This selection is specific to the operating system where the
import file was created:
Character Set

Sort Order





Windows ANSI (Windows)
Mac Roman (Mac)
ISO 8859-1 (Unix)

Enter the order that this record appears on the AutoComm Setup
page.
If you do not make a selection, the order will be alphabetical by
the name of the AutoComm record.
Do one of the following:


Update existing
records with
imported data
(when applicable)

Import



Select the checkbox if you want the system to update
existing student records with data from each import. The
system updates blank fields within records and creates
new records for those that do not exist.
Deselect the checkbox if you do not want the system to
update any record that contains data.

Note: Only an administrator can update the attendance table.
This is to prevent other users from overwriting the administrator’s
modifications. To avoid accidental overwrites, AutoComm is not
set up with administrative rights when running automatically.
When importing data to update current attendance records, an
administrator can run AutoComm manually. For more
information, see How to Manually Run an AutoComm Record.
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Mark students and
their schedules
inactive when their
exit date is <= today.

If you want the system to automatically import a student record
as inactive if the student's exit date is earlier than today, select the
checkbox. Otherwise, deselect the checkbox.

The system does not import the file if the number of records in it
First record of file is
does not match the number given in the first record of the file. It
number_of_records=
is recommended that you select the checkbox.

E-Mail completion
report to

Enter the email addresses of the people you want the system to
send a completion report to each time it imports this file.
Separate multiple addresses with commas.
Enter the PowerSchool fields in which the system saves each value
in the import file. After you enter each field code, press RETURN
(Mac) or ENTER (Windows).
To insert a PowerSchool field into this field:
1. Click Student Field List to view a list of PowerSchool
student fields. The Student Field List pop-up appears.
2. To narrow the list of fields, enter one of more search terms
in the Filter field. Otherwise, leave blank.
3. Click the field you want to add. The Student Field List popup closes and the selected field appears.

PowerSchool fields
to import into

Importing to the Attendance table requires some specific field
names: Daily Attendance





Student_Number
Att_Date
Schoolid
Attendance_CodeID

Meeting Attendance





Import
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Att_Date
Course_Number
Section_Number
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Schoolid
Attendance_CodeID

Note: When creating the import file, remove the column
headings; only record data should be in the file. Create the file in
Excel and save it as a tab- delimited file. The data in the file should
be in the same order as the field names listed in the AutoComm
Record.
Note: If you are adding database extension fields, enter the
extension field name using the format [extension
name].[fieldname].

Duplicate this
AutoComm record
to all schools on this
server

If you are creating this record for the first time, select the
checkbox to make the record available to all schools that use your
PowerSchool system. Otherwise, deselect the checkbox.
Note: If working in the District mode, you can modify only the
Students and Teachers tables.

5. Click Submit. The AutoComm Setup page displays the new record.

How to Edit an AutoComm Record
1. On the start page, choose System under Setup in the main menu. The System
Administrator page appears.
2. Under Data Management, click AutoComm Setup. The AutoComm Setup page
appears.
3. Click the name of the AutoComm record you want to edit. The AutoComm Record
page appears.
4. Edit this information as needed. For field descriptions, see How to Add an AutoComm
Record.
5. Click Submit. The AutoComm Setup page displays the edited record.

How to Delete an AutoComm Record
1. On the start page, choose System under Setup in the main menu. The System
Administrator page appears.
2. Under Data Management, click AutoComm Setup. The AutoComm Setup page
appears.
Import
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3. Click the name of the AutoComm record you want to delete. The AutoComm Record
page appears.
4. Click Delete.
5. Click Confirm Delete. The Selection Deleted page appears.

How to Manually Run an AutoComm Record
Manually run an AutoComm record to avoid waiting for the process to automatically run on
the specified day and time.
1. On the start page, choose System under Setup in the main menu. The System
Administrator page appears.
2. Under Data Management, click AutoComm Setup. The AutoComm Setup page
appears.
3. Click Run Now. The AutoComm record runs, and the AutoComm Setup page
appears. If an email address is specified in the "E-Mail completion report to" field,
the system emails the recipient the status of the AutoComm process.

Import
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Data Import Manager
Using the Data Import Manager, you can quickly and easily import data from a text file into
PowerSchool.
Note: Currently data may only be imported into the Course Archive, Incident, Student
Email, Transportation and Custom Table data sets. Additional data sets will be made
available in future releases.

Set Page-Level Permissions
To ensure that only authorized staff members access the data import pages, set page-level
permissions for Start Page > Special Functions under Functions in the main menu >
Importing & Exporting > Data Import Manager under Importing. For more information
about setting page-level permissions, see Security Permissions.

Preparing Your Import File
General Information
Before importing data, you will need to create an import file. When creating your import
file, it is important to note the following:






Do not use a double quote (") as the field delimiter.
The double quote is a reserved character and may only be used to ignore other
delimiters.
Field delimiters are regarded as literals if the field value is surrounded by double
quotes.
Strings are regarded as literals if surrounded by double quotes.
Double quotes that are surrounded by double quotes are regarded as part of the
value.

Example 1
Field delimiter as a literal in the field value:
First Name, Last Name, Address
John, Smith, "123 Anyplace Dr, Ste 100"

Data Import Manager
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Results:
FirstName LastName Address
John

Smith

123 Anyplace Dr, Ste 100

Example 2
Field delimiter as a literal in the field value surrounded by double quotes:
First Name, Last Name, Address
John, Smith, """123 Anyplace Dr, Ste 100"""
Results:
FirstName LastName Address
John

Smith

"123 Anyplace Dr, Ste 100"

Example 3
Double quotes used to escape a field delimiter:
First Name, Last Name, Address
John, Smith, 123 Anyplace Dr"," Ste 100
Produces the following results:
FirstName LastName Address
John

Smith

123 Anyplace Dr, Ste 100

Example 4
Quote within a field value:
First Name, Last Name, Address
John, Smith, 123 Anyplace """Dr,""" Ste 100
Produces the following results:
FirstName LastName Address
John

Smith

123 Anyplace "Dr," Ste 100

Example 5
Without the double quotes, the field delimiter is not escaped:
First Name, Last Name, Address
John, Smith, 123 Anyplace Dr, Ste 100
Produces the following results:
FirstName

LastName

Address

John

Smith

123 Anyplace Dr

Data Import Manager
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Incident Import File
PowerSchool’s Incident Management schema spans several complex tables that would
otherwise require multiple separate imports to create a single incident. The incident data
set in the Data Import Manager allows administrators to import incident records using a
flat file import. The flat-file information is translated behind the scenes to fit the actual
tables used for incident records.
A single incident can include multiple attributes, participants, actions, objects, or behaviors.
As such, the incident import data set allows these column groups to be repeated in your
import file to represent multiple groupings of the above items.
Incident Element Hierarchy
Within the incident element hierarchy, elements are categorized as a parent, sibling, or
child element. Parent and sibling elements can be listed in any order. Child elements must
be listed after a parent element in order for the fields to be valid.


Incident
 Incident_Attribute
 Action
 Action_Attribute
 Object
 Behavior
 Participant
 Participant_Attribute
 Participant_Role
 Participant_Object
 Participant_Action
 Participant_Action_Attribute
 Participant_Behavior
 Participant_Behavior_Action
 Participant_Behavior_Action_Attribute

Data Element

Incident

Description
When creating your incident import file, you may
include the following data (based on your
PowerSchool incident management setup) for each
incident you are importing:


Data Import Manager

Incident_ID
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Incident_School_Number
Incident_Title
Incident_Description
Incident_Prepared_By
Incident_Incident_Type
Incident_Incident_Date
Incident_Incident_Time
Incident_Time_Frame_Code
Incident_Time_Frame_Subcode
Incident_Time_Frame_Comment
Incident_Financial_Impact
Incident_Location_Code
Incident_Location_Subcode
Incident_Location_Description

Note: If Incident_School_Number is mapped, then
the incident is associated with the mapped school or
district office. If Incident_School_Number is not
mapped, then the incident is associated with the
current school.
Note: For field descriptions, see Incident
Management. When importing, these fields may only
be mapped once. For more information, see Step 6
of How to Import Data Using the Data Import Manager.
Within the incident import file, these fields must be
listed after an Incident in order for the fields to be
valid. For each incident attribute in the incident data
set, you may include the following data (based on
your PowerSchool incident management setup):
Incident_Attribute





Incident_Attribute_Code
Incident_Attribute_Subcode (required if code
is divided into sub codes)
Incident_Attribute_Comment (may be
forbidden, allowed or required based on
configuration)

Note: For field descriptions, see Incident
Management. When importing, these fields may be
Data Import Manager
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mapped one or more times. For more information,
see Step 6 of How to Import Data Using the Data
Import Manager.
Within the incident import file, these fields must be
listed after an Incident in order for the fields to be
valid. For each action in the incident data set, you
may include the following data (based on your
PowerSchool incident management setup):




Action

















Action_Code
Action_Subcode (required if code is divided
into sub codes)
Action_Comment (may be forbidden, allowed
or required based on configuration)
Action_Begin_Date
Action_End_Date
Action Taken Detail
Actual_Resolution_Date
Action_Duration_Code
Action_Duration_Subcode (required if code is
divided into sub codes)
Action_Duration_Comment (may be
forbidden, allowed or required based on
configuration)
Action_Assigned_Duration
Action_Actual_Duration
Action_Duration_Notes
Action_Change_Reason
Action_Change_Code
Action_Change_Subcode (required if Action
Change Code is broken into sub codes)
Action_Change_Comment (may be forbidden,
allowed or required based on action change
code configuration)

Note: For field descriptions, see Incident
Management. When importing, these fields may be
mapped one or more times. For more information,

Data Import Manager
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see Step 6 of How to Import Data Using the Data
Import Manager.
Within the incident import file, these fields must be
listed after an Action in order for the fields to be
valid. For each action attribute in the incident data
set, you may include the following data (based on
your PowerSchool incident management setup):



Action_Attribute





Action_Attribute_Code
Action_Attribute_Subcode (required if code is
divided into sub codes)
Action_Attribute_Comment (may be
forbidden, allowed or required based on
configuration)
Action_Attribute_Value (content of value field
depends on configuration)

Note: For field descriptions, see Incident
Management. When importing, these fields may be
mapped one or more times. For more information,
see Step 6 of How to Import Data Using the Data
Import Manager.
Within the incident import file, these fields must be
listed after an Incident in order for the fields to be
valid. For each object in the incident data set, you
may include the following data (based on your
PowerSchool incident management setup):

Object







Object_Code
Object_Subcode (required if code is divided
into sub codes)
Object_Comment (may be forbidden, allowed
or required based on configuration)
Object_Description
Object_Quantity

Note: For field descriptions, see Incident
Management. When importing, these fields may be
Data Import Manager
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mapped one or more times. For more information,
see Step 6 of How to Import Data Using the Data
Import Manager.
Within the incident import file, these fields must be
listed after an Incident in order for the fields to be
valid. For each behavior in the incident data set, you
may include the following data (based on your
PowerSchool incident management setup):





Behavior




Behavior_Code
Behavior_Subcode (required if code is divided
into sub codes)
Behavior_Subcode_2 (required if sub codes is
divided into sub codes)
Behavior_Subcode_3 (required if sub codes is
divided into sub codes)
Behavior_Subcode_4 (required if sub codes is
divided into sub codes)
Behavior_Comment (may be forbidden,
allowed or required based on configuration)
Behavior_Primary (use value Primary or leave
blank)

Note: For field descriptions, see Incident
Management. When importing, these fields may be
mapped one or more times. For more information,
see Step 6 of How to Import Data Using the Data
Import Manager.

Participant

Within the incident import file, these fields must be
listed after an Incident in order for the fields to be
valid. For each participant in the incident data set,
you may include the following data (based on your
PowerSchool incident management setup):


Data Import Manager

Participant_Student_Number (cannot be
populated if Teacher_Number is also
populated)
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Participant_Teacher_Number (cannot be
populated if Student_Number is also
populated)
Participant_Unknown (cannot be populated if
Student_Number or Teacher_Number is also
populated)
Participant_First (cannot be populated if
Student_Number or Teacher_Number is also
populated)
Participant_Middle (cannot be populated if
Student_Number or Teacher_Number is also
populated)
Participant_Last (cannot be populated if
Student_Number or Teacher_Number is also
populated)
Participant_Position (cannot be populated if
Student_Number or Teacher_Number is also
populated)
Participant_Age (cannot be populated if
Student_Number or Teacher_Number is also
populated)
Participant_Gender (cannot be populated if
Student_Number or Teacher_Number is also
populated)

Note: For field descriptions, see Incident
Management. When importing, these fields may be
mapped one or more times. For more information,
see Step 6 of How to Import Data Using the Data
Import Manager.

Participant_Attribute

Within the incident import file, these fields must be
listed after a Participant in order for the fields to be
valid. For each participant attribute in the incident
data set, you may include the following data (based
on your PowerSchool incident management setup):



Data Import Manager

Participant_Attribute_Code
Participant_Attribute_Subcode (required if
code is divided into sub codes)
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Participant_Attribute_Comment (may be
forbidden, allowed or required based on
configuration)

Note: For field descriptions, see Incident
Management. When importing, these fields may be
mapped one or more times. For more information,
see Step 6 of How to Import Data Using the Data
Import Manager.
Within the incident import file, these fields must be
listed after a Participant in order for the fields to be
valid. For each participant role in the incident data
set, you may include the following data (based on
your PowerSchool incident management setup):



Participant_Role


Participant_Role_Code (required if preceded
by Participant)
Participant_Role_Subcode (required if code is
divided into sub codes)
Participant_Role_Comment (may be
forbidden, allowed or required based on
configuration)

Note: For field descriptions, see Incident
Management. When importing, these fields may be
mapped one or more times. For more information,
see Step 6 of How to Import Data Using the Data
Import Manager.

Particpant_Object

Within the incident import file, these fields must be
listed after a Participant_Role in order for the fields
to be valid. For each participant object in the incident
data set, you may include the following data (based
on your PowerSchool incident management setup):



Data Import Manager

Participant_Object_Code
Participant_Object_Subcode (required if code
is divided into sub codes)
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Participant_Object_Comment (may be
forbidden, allowed or required based on
configuration)
Participant_Object_Description
Participant_Object_Quantity

Note: For field descriptions, see Incident
Management. When importing, these fields may be
mapped one or more times. For more information,
see Step 6 of How to Import Data Using the Data
Import Manager.
Within the incident import file, these fields must be
listed after a Participant_Role in order for the fields
to be valid. For each participant action in the incident
data set, you may include the following data (based
on your PowerSchool incident management setup):




Participant_Action















Data Import Manager

Participant_Action_Code
Participant_Action_Subcode (required if code
is divided into sub codes)
Participant_Action_Comment (may be
forbidden, allowed or required based on
configuration)
Participant_Action_Begin_Date
Participant_Action_End_Date
Participant_Action_Taken_Detail
Participant_Actual_Resolution_Date
Participant_Action_Duration_Code
Participant_Action_Duration_Subcode
(required if code is divided into sub codes)
Participant_Action_Duration_Comment (may
be forbidden, allowed or required based on
configuration)
Participant_Assigned_Duration
Participant_Actual_Duration
Participant_Duration_Notes
Participant_Action_Change_Reason
Participant_Action_Change_Code
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Participant_Action_Change_Subcode (required
if code is divided into sub codes)
Participant_Action_Change_Comment (may be
forbidden, allowed or required based on
configuration)

Note: For field descriptions, see Incident
Management. When importing, these fields may be
mapped one or more times. For more information,
see Step 6 of How to Import Data Using the Data
Import Manager.
Within the incident import file, these fields must be
listed after a Participant_Action in order for the fields
to be valid. For each participant action attribute in
the incident data set, you may include the following
data (based on your PowerSchool incident
management setup):



Participant_Action_Attribute





Participant_Action_Attribute_Code
Participant_Action_Attribute_Subcode
(required if code is divided into sub codes)
Participant_Action_Attribute_Comment (may
be forbidden, allowed or required based on
configuration)
Participant_Action_Attribute_Value (content of
value field depends on configuration)

Note: For field descriptions, see Incident
Management. When importing, these fields may be
mapped one or more times. For more information,
see Step 6 of How to Import Data Using the Data
Import Manager.

Participant_Behavior

Data Import Manager

Within the incident import file, these fields must be
listed after a Participant_Role in order for the fields
to be valid. For each participant behavior in the
incident data set, you may include the following data
(based on your PowerSchool incident management
setup):
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Participant_Behavior_Code
Participant_Behavior_Subcode (required if
code is divided into sub codes)
Participant_Behavior_Subcode_2 (required if
sub codes is divided into sub codes)
Participant_Behavior_Subcode_3 (required if
sub codes is divided into sub codes)
Participant_Behavior_Subcode_4 (required if
sub codes is divided into sub codes)
Participant_Behavior_Comment (may be
forbidden, allowed or required based on
configuration)
Participant_Behavior_Primary (use value
Primary or leave blank)

Note: For field descriptions, see Incident
Management. When importing, these fields may be
mapped one or more times. For more information,
see Step 6 of How to Import Data Using the Data
Import Manager.
Within the incident import file, these fields must be
listed after a Participant_Behavior in order for the
fields to be valid. For each participant behavior
action in the incident data set, you may include the
following data (based on your PowerSchool incident
management setup):

Participant_Behavior_Action










Data Import Manager

Participant_Behavior_Action_Code
Participant_Behavior_Action_Subcode
(required if code is divided into sub codes)
Participant_Behavior_Action_Comment (may
be forbidden, allowed or required based on
configuration)
Participant_Behavior_Action_Begin_Date
Participant_Behavior_Action_End_Date
Participant_Behavior_Action_Taken_Detail
Participant_Behavior_Action_Actual_Resolutio
n_Date
Participant_Behavior_Action_Duration_Code
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Participant_Behavior_Action_Duration_Subcod
e (required if code is divided into sub codes)
Participant_Behavior_Action_Duration_Comm
ent (may be forbidden, allowed or required
based on configuration)
Participant_Behavior_Action_Assigned_Durati
on
Participant_Behavior_Action_Actual_Duration
Participant_Behavior_Action_Duration_Notes
Participant_Behavior_Action_Change_Reason
Participant_Behavior_Action_Change_Code
Participant_Behavior_Action_Change_Subcode
(required if code is divided into sub codes)
Participant_Behavior_Action_Change_Comme
nt (may be forbidden, allowed or required
based on configuration)

Note: For field descriptions, see Incident
Management. When importing, these fields may be
mapped one or more times. For more information,
see Step 6 of How to Import Data Using the Data
Import Manager.
Within the incident import file, these fields must be
listed after a Participant_Behavior_Action in order for
the fields to be valid. For each participant behavior
action attribute in the incident data set, you may
include the following data (based on your
PowerSchool incident management setup):
Participant_Behavior_Action_Attri
bute







Data Import Manager

Participant_Behavior_Action_Attribute_Code
Participant_Behavior_Action_Attribute_Subcod
e (required if code is divided into sub codes)
Participant_Behavior_Action_Attribute_Comm
ent (may be forbidden, allowed or required
based on configuration)
Participant_Behavior_Action_Attribute_Value
(content of value field depends on
configuration)
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Note: For field descriptions, see Incident
Management. When importing, these fields may be
mapped one or more times. For more information,
see Step 6 of How to Import Data Using the Data
Import Manager.

Importing into Custom Tables
The Data Import Manager allows administrators to import data into custom tables. These
tables are not part of the core PowerSchool schema, but are created by PowerSchool
custom development groups.





Custom Tables are listed in the Import Into pop-up menu on the Data Import
Manager page using the name of the custom table.
Custom table fields are available for select data sets in the Data Import Manager
when mapping fields from the import file to PowerSchool.
 If the custom table is a 1-to-1 child table, administrators must map one of the
fields in the import file to the foreign key field in the custom table.
 If the custom table is a 1-to-many child table, administrators must map one
of the fields in the import file to the foreign key field in the custom table
when adding child records.
 When updating existing records in the custom table, administrators must
map one of the fields in the import file to the primary key field. The foreign
key field is ignored if the primary key field is mapped and present for the
record. This means that it is not possible to update a foreign key value.
 If the custom table is a stand-alone table that does not have a parent table,
administrators must map one of the fields in the import file to the primary
key field only when attempting to update an existing record.
When mapping custom table fields, the fields appear in the following order:
 If the custom table is a 1-to-1 extension of a core table, after the last core
field within the import module, the foreign key to the parent table appears
first and then all the other custom table fields appear in alphabetical order.
 If the custom table is a 1-to-many child extension of a core table, after the
core table, the custom child table fields are grouped and appear in
alphabetical order. The foreign key to the parent table appears first, the
primary key appears second, and then all the other custom table fields
appear in alphabetical order.
 If the custom table is a stand-alone table that does not have a parent table,
the primary key appears first and then all the other custom table fields
appear in alphabetical order.

Data Import Manager
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Standard import options are available when importing into a custom table.
 Administrators can choose whether or not to exclude the first row if it
contains headers.
 Administrators can choose whether or not to update existing records if a
match is found.
Data being imported into a custom table will be validated based on the data type
and other field attributes. Data types include:
 Text must be a text value less than or equal to the database field's length
property.
 Integer must be a whole number less than or equal to 19 digits long.
 Double must be a numeric value with up to one decimal point and be less
than or equal 19 digits long.
 Boolean must be a numeric value of 0 or 1.
 Date must be a valid m/d/y format where m can be 1-12, d can be 1-31 and y
can be two digits (05) or four digits (2005).
Import results for an import into a custom table are displayed in the Import Results
page.

Import Data Using the Data Import Manager
Once you have prepared your import file, you can import the data using the Data Import
Manager.

How to Import Data Using the Data Import Manager
Note: Verify that you are signed in to the appropriate school. If the school is incorrect, click
School at the top of the page to choose a new school before starting this procedure.
Note: The Data Import Manager page is now also accessible via Start > System > Page
and Data Management > Data Import Manager.
1. On the start page, choose Special Functions under Functions in the main menu.
The Special Functions page appears.
2. Click Importing & Exporting. The Importing & Exporting page appears.
3. Click Data Import Manager. The Data Import Manager page appears.
4. Use the following table to enter information in the Select Source and Target fields:

Data Import Manager
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Field

Description

Source

Enter the file path and name of the file to import or click Choose
File (or Browse), navigate to the data file, and click Open.
Indicate which data set you want to import the data into by
choosing one of the following from the pop-up menu:

Import Into








Course Archive
Course Equivalency
Incident
[Custom Table]
Student Email
Transportation

Note: Custom tables only appear if your district allows importing
into custom tables at the school level.
Use the pop-up menu to choose which delimiter to use to
separate the fields in the exported data from the pop-up menu:

Field Delimiter





Tab
Comma
Other: Enter the field delimiter in the adjacent field.

Note: Adjacent field only appears editable if Other is selected.
Note: Only one character may be entered. A double quote
character is not allowed.
Note: This field only appears if applicable to the Import Into
selection.

Character Set

Use the pop-up menu to choose the character set for the import
file. This selection is specific to the operating system where the
import file was created:




Data Import Manager

Unicode
Windows ANSI (Windows)
Mac Roman (Mac)
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ISO 8859-1 (Unix)

Note: This field only appears if applicable to the Import Into
selection.
5. Click Next or the Map Columns header.
Note: The Next button and the Map Columns header appear shaded until the
Source and Import Into are populated.
6. Use the following table to enter information in the Map Columns fields:
Field

Description
To apply a template:
1. Click Select Template. The Select Import Template pop-up
appears.
2. Select the template you want to apply.
3. Note the mapped fields that are included in the template
appear in the lower portion of the pop-up.
4. Click Apply. The Select Import Template pop-up closes.
To delete a template:

Select Template

1. Click Select Template. The Select Import Template pop-up
appears.
2. Select the template you want to delete.
3. Click Delete.
4. Click Confirm Delete. A confirmation message appears.
5. Click Close. The Select Import Template pop-up closes.
Note: If no templates have been saved, this button appears
disabled.
Note: Click column headings to sort templates in ascending order.
Click again to sort in descending order.

Import File Column

Data Import Manager
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This section displays the suggested PowerSchool field for each
field from the import file. To map a field from the import file,
choose a PowerSchool field from the pop-up menu.
Student Email

PowerSchool Field

For Student Email, only Student Number and Email appear
mapped. Student Number is required for importing Student
Emails. All other imported fields appear blank.
Incident
Primary fields in the Incident data set may only be mapped once.
Secondary fields may be mapped one or more times. For more
information, see the Incident Import File section under Preparing
Your Import File.
If you import the same fields of data frequently, you can create a
template so that you don't have to define the field import map
every time you perform an import.
To create a new template:

Save Template

1.
2.
3.
4.
5.

Click Save Template. The Save Template pop-up appears.
Enter the name of the template.
Enter a description of the template.
Note the mapped fields that are included in the template.
Click Save as New. The Save Template pop-up closes and a
confirmation message appears.

To edit a template:
1.
2.
3.
4.

Click Save Template. The Save Template pop-up appears.
Edit the description of the template.
Note the mapped fields that are included in the template.
Click Save. The Save Template pop-up closes and a
confirmation message appears.

7. Click Next or the Select Options header.
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Note: The Next button and the Select Options header appear shaded until at least
one column is mapped, an identifier (required field) is mapped, and the same
primary column is not mapped more than once.
8. Use the following table to enter information in the Select Options fields:
Field

Description
Do one of the following:

Check to exclude
the first row.




Select the checkbox to prevent importing the header row.
Deselect the checkbox to import the first row. This should
be used if your import file does not contain a header row.

Note: If one or more columns are auto-mapped, the checkbox is
automatically selected. If no columns are auto-mapped, the
checkbox is not automatically selected.
If you are importing to the Student Email table, select one of the
following options to determine what you want the system to do
when a student record in the import file contains a student ID
number that already exists in PowerSchool:
If a record in the
import file matches
an existing record in
the database, how
would you like that
record processed?





If you do not want the system to import any record with a
student number that already exists, select Do not process
that record from the import file.
If you want the system to update the matching student's
record with the data in the import file, select Update the
existing record with information from the file being
imported.

Note: This field does not appear if you are importing to the
Incident table.
9. Click Import. The Import Results page displays a summary of the processed
records:
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Field

Description
Click to update the status of the report.
To set the automatic page refresh:

Refresh

1. On the Refresh button, click the arrow. A pop-up menu
displays the units of time you can set for the automatic
page updates; 30 seconds, one minute, five minutes, or 10
minutes.
2. Select a value from the pop-up menu. A countdown clock
appears on the Refresh button and displays the time until
the page updates, based on your selection.
3. To cancel the automatic page refresh, click the arrow and
select the Cancel button.

The first number represents the number of records processed.
Processed # out of #
The second number represents the total number of records in the
records
import file including the header row.
Incident
If a record could not be imported due to an error, the row number
of the record along with one of the following reasons appear:




Failed





Data Import Manager

<code type> sub_code specified without code
Returned if a sub_code was specified without a parent
code.
<code type> comment specified without code
Returned if a comment was specified without a parent
code.
Invalid <code type> code
Returned if the specified code is not valid.
Specified <code type> code does not allow sub_codes
Returned if a sub_code is specified for a parent code that is
not split into sub_codes.
Specified <code type> sub_code1 does not allow
sub_codes
Returned if a sub_code is specified for a parent sub_code
that is not split into sub_codes.
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Specified <code type> sub_code2 does not allow
sub_codes
Returned if a sub_code is specified for a parent sub_code
that is not split into sub_codes.
Specified <code type> sub_code3 does not allow
sub_codes
Returned if a sub_code is specified for a parent sub_code
that is not split into sub_codes.
Invalid <code type> sub_code
Returned if the specified sub_code is not defined for the
parent code.
Invalid <code type> sub_code1
Returned if the specified sub_code is not defined for the
parent sub_code.
Invalid <code type> sub_code2
Returned if the specified sub_code is not defined for the
parent sub_code.
Invalid <code type> sub_code3
Returned if the specified sub_code is not defined for the
parent sub_code.
Invalid <code type> sub_code4
Returned if the specified sub_code is not defined for the
parent sub_code.
<code type> comment is not allowed
Returned if a comment was specified but is not allowed for
the specified code or sub_code.
<code type> comment is required
Returned if a comment was not specified but is required
for the specified code or sub_code.
<code type> primary must be primary must be True,
False, 1, 0 or Primary
Returned if the specified primary attribute is not valid.
Multiple <code type> were specified as primary
Returned if the more than one code was specified as
primary.
<code type> code requires sub_code
Returned if the specified code is split into sub_codes and
no sub_code was specified.
<code type> sub_code1 requires sub_code
Returned if the specified sub_code is split into sub_codes
and no sub_code was specified.
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<code type> sub_code2 requires sub_code
Returned if the specified sub_code is split into sub_codes
and no sub_code was specified.
<code type> sub_code3 requires sub_code
Returned if the specified sub_code is split into sub_codes
and no sub_code was specified.

Note: The <code type> portion of the message will be replace by
the applicable code type that had the error.
In addition to the above errors, a record may not be imported due
to a data validation error. If a data validation error occurs, "[field
name]: " appears along with one or more of the following
explanations:











Empty value is not allowed
Value may not contain more than [#] character(s)
Value must be a number
Value must be a valid date
Value must be an integer
Value must be at least [#]
Value must be less than or equal to [#]
Value must be on or after [date]
Value must be on or before [date]
Value must contain at least [#] character(s)

Student Email
If a record could not be imported due to an error, the row number
of the record along with one of the following reasons appear:




Email already exists
Student not found
Student number not found

Note: Click column heading to sort in ascending order. Click again
to sort in descending order.
Imported

Data Import Manager

If a record was successfully imported, the row number of the
record along with one of the following results appears indicating
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whether an imported record was cleared, added, ignored, or
updated during the import:





Deleted
Inserted
Skipped
Updated

Note: Click column heading to sort in ascending order. Click again
to sort in descending order.

Download Failed
Records

Click to download the failed records. Downloaded file appears in
the format of the original import file. This can be used to easily
identify which records had problems during import so that
corrections can be made and the import can be reattempted.
Note: This button is only available once the import process has
completed.

Data Import Queue
Use the Data Import Queue to view the results of import jobs that you have submitted
using the Data Import Manager. When you submit an import request to the system, the
system captures the import request and transmits the job to the Data Import Queue. The
Data Import Queue page displays the status of the import job as it is processed by the
system.

How to Use the Data Import Queue
Note: The Data Import Queue page is now also accessible via Start > System > Page and
Data Management > Data Import Queue.
1. On the start page, choose Special Functions under Functions in the main menu.
The Special Functions page appears.
2. Click Importing & Exporting. The Importing & Exporting page appears.
3. Click Data Import Queue. The Data Import Queue page appears.
4. Use the following table to enter information in the fields:
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Field

Description
Click to update the status of the queue.
To set the automatic page refresh:

Refresh

1. On the Refresh button, click the arrow. A pop-up menu
displays the units of time you can set for the automatic
page updates; 30 seconds, one minute, five minutes, or 10
minutes.
2. Select a value from the pop-up menu. A countdown clock
appears on the Refresh button and displays the time until
the page updates, based on your selection.
3. To cancel the automatic page refresh, click the arrow and
select the Cancel button.

Import File

The name of the imported file.

Import Into

The data set being imported into.

School

The name of the school for which the file was imported.

Start Date/Time

The date and time the import started appears.

End Date/Time

The date and time the import ended appears.
Note: This field only displays when the import has completed.
The status of the import appears:

Status





In progress
Complete
Complete with some failures

Click to view the Import Results page.
Delete

Data Import Manager

Click to delete the import.
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View Imported Data
Once you imported data, you can then view the imported the data using the appropriate
PowerSchool page.

How to View Imported Course By Year Data
Navigate to the View Course Information By Year page for a selected course. For more
information, see How to Edit Course Information.

How to View Imported Incident Data
Navigate to the Incident Detail page for a selected student. For more information, see How
to Edit a Discipline Incident.

How to View Imported Student Email Data
Navigate to the Student Email / Email Configuration page for a selected student. For more
information, see How to Configure Student Email.

How to View Imported Transportation Data
Navigate to the Transportation Entry page for a selected student. For more information,
see How to Edit Transportation Information.

Data Import Manager
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Export
Quick Export
This method quickly produces a simple list of students and information from the Student
table. Change the parameters to produce a more detailed list. For more information about
exporting, see How to Export Using a Template.
In addition to exporting data, SIS Views provide quick access to key metrics and not just
raw data. For detailed information, see the Data Dictionary SIS Views available on
PowerSource.

How to Use Quick Export
Note: The Quick Export page is now also accessible via Start > System > Page and Data
Management > Quick Export.
1. On the start page, search for and select a group of students. A list of students
appears in the Current Student Selection section. For more information, see Select a
Group of Students.
2. Click the [Select Function] arrow. The Group Functions pop-up menu appears.
3. Under Export, choose Quick Export. In most cases, you will not need to change the
default options on the Export Students page, in which case you can skip the next
step. To change the selections, proceed to the next step.
Note: Alternatively, if you have a current selection of students, you can choose
Special Functions under Functions in the main menu and then click Groups
Functions.
4. Use the following table to enter information in the fields:
Field

Description

[Fields to be
Exported]

Enter the fields to be included on the exported spreadsheet. Enter
as many fields as needed. Enter only one field per line. Separate
multiple fields with a hard return.
To insert a PowerSchool field into this field:
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1. Click Fields at the bottom of the page to view a list of
PowerSchool fields. The Fields pop-up appears.
2. To narrow the list of fields, enter one of more search terms
in the Filter field. Otherwise, leave blank.
3. Click the field you want to add. The Fields pop-up closes
and the selected field appears.
Note: Database extension fields can be selected on the Fields
pop-up. For more information, see Database Extensions in the
System Administrator User Guide available on PowerSource.
A field delimiter separates fields (or "columns") in the exported
data. Use the pop-up menu to choose how you want the system
to separate each field in the export file:
Field Delimiter






Tab
Comma
None
Other: Enter the delimiter in the blank field.

A record delimiter separates records (or "rows") in the exported
data. Use the pop-up menu to choose how you want the system
to separate each record in the export file:
Record Delimiter






CR: Carriage return
CRLF: Carriage return and line feed
LF: Line feed
Other: Enter the delimiter in the blank field.

Surround Fields

Select the checkbox to surround the fields in the exported data
with quotation marks.

Column titles on 1st
row

Select the checkbox to include column titles on the first row of the
exported data.

Export DCID

Select the checkbox to export the Student table's unique
identifier.

Export
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5. Click Submit. The exported data appears.
6. Choose File > Save As... to save the file. Open the saved file using a spreadsheet
application, such as Excel or Lotus 1-2-3. Format, print, and save it as any other
spreadsheet document.

Templates for Exporting
Export information by using a template. Select the template from a list or create a new one.
For more information about exporting, see Quick Export.
Database Extensions and Export Templates
Users can add table extension fields to export templates created for the selected table
using the following methods for the Data to Export field:



For Student and Users tables, click Fields and select from the pop-up.
For Courses, Historical Grades, and Student Schedules tables, enter the database
extension field name manually.

How to Create an Export Template
If there is no template that you can use to perform the export or no template you can edit
to meet your needs, you must create a new one.
Note: The Export Using Template page is now also accessible via Start > System > Page
and Data Management > Export Using Template. Additionally, the Templates for
Exporting page is now also accessible via Start > System > Page and Data Management >
Templates for Exporting.
1. On the start page, search for and select a group of students. A list of students
appears in the Current Student Selection section. For more information, see Select a
Group of Students.
2. Click the [Select Function] arrow. The Group Functions pop-up menu appears.
3. Under Export, choose Export Using Template. The Export Using Template page
appears.
Note: Alternatively, if you have a current selection of students, you can choose
Special Functions under Functions in the main menu and then click Groups
Functions.
4. Choose the type of export from the Type of Export pop-up menu. The Export Using
Template page appears.
Export
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5. Click Template. The Templates for Exporting page appears.
6. Click New. The New Export Template page appears.
7. Use the following table to enter information in the fields:
Field

Description

Name of this
template

Enter a name for the template.

Export from this
table

Choose the table that will be used in the export from the pop-up
menu.

Delimited or fixedfield length?

Choose either Delimited or Fixed from the pop-up menu to
determine the length of each field.

Field delimiter

If you chose Delimited in the previous field, use the pop-up menu
to choose the field delimiter. This refers to the item that will
separate the fields in the exported data. If you choose Other,
enter the delimiter in the blank field.
Select the checkbox to surround field values with quotation
marks.

End-of-line (record)
delimiter

Choose the delimiter for the end of each record from the pop-up
menu. For Other:, enter the delimiter in the blank field.

Column Titles

Select the checkbox to put column titles on the first row.

Mime Type

Enter a MIME type. To use the default MIME type, leave the field
blank. For more information, see MIME Types.

8. Click Submit. The Templates for Exporting page displays the new template. Add
columns to the template using the procedure How to Add Template Columns.

How to Add Template Columns
Note: The Export Using Template page is now also accessible via Start > System > Page
and Data Management > Export Using Template. Additionally, the Templates for
Export
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Exporting page is now also accessible via Start > System > Page and Data Management >
Templates for Exporting.
1. On the start page, search for and select a group of students. A list of students
appears in the Current Student Selection section. For more information, see Select a
Group of Students.
2. Click the [Select Function] arrow. The Group Functions pop-up menu appears.
3. Under Export, choose Export Using Template. The Export Using Template page
appears.
Note: Alternatively, if you have a current selection of students, you can choose
Special Functions under Functions in the main menu and then click Groups
Functions.
4. Choose the type of export from the Type of Export pop-up menu. The Export Using
Template page appears.
5. Click Template. The Templates for Exporting page appears.
6. Click the # Columns link of the template to be changed. The Edit Columns page
appears.
7. Click New to add a column to the template. The New Column page appears.
8. Use the following table to enter information in the fields:
Field

Description

Title/Heading

Enter a title for the column.
Enter the fields to be included in the export.
To insert a PowerSchool field into this field:

Data to Export

1. Click Fields to view a list of PowerSchool fields. The Fields
pop-up appears.
2. To narrow the list of fields, enter one of more search terms
in the Filter field. Otherwise, leave blank.
3. Click the field you want to add. The Fields pop-up closes
and the selected field appears.
Note: If you are adding database extension fields for Courses,
Historical Grades, and Student Schedules tables, enter the
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extension field name using the format [extension
name].[fieldname].

If Blank, Export This

If a record has no data for a particular field, indicate a value to
replace the blank field (optional). For example, enter No Data.

Column Number

Enter a column number for this column on the template. All
column numbers will have a zero added as a suffix to the column
number.

Width in Characters

Enter the width of the column in characters if using fixed-field
lengths instead of field delimiters.

Alignment

Use the pop-up menu to choose the alignment of the column if
using fixed-field lengths instead of field delimiters.

9. Click Submit. The Edit Columns page appears.
10. Repeat the previous three steps to add additional columns to the template.
11. Click Back to Templates for Exporting. The Templates for Exporting page appears.
The template has been changed. Perform the export by following the instructions in the
section Export Using a Template.

How to Edit a Template
When you need a list that differs slightly from the list that a template produces, you can
easily modify the template to meet your needs.
Note: Everyone who uses the template will view the changes you enter. Contact other
users before changing a template that many people use.
Note: The Export Using Template page is now also accessible via Start > System > Page
and Data Management > Export Using Template. Additionally, the Templates for
Exporting page is now also accessible via Start > System > Page and Data Management >
Templates for Exporting.
1. On the start page, search for and select a group of students. A list of students
appears in the Current Student Selection section. For more information, see Select a
Group of Students.
2. Click the [Select Function] arrow. The Group Functions pop-up menu appears.
Export
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3. Under Export, choose Export Using Template. The Export Using Template page
appears.
Note: Alternatively, if you have a current selection of students, you can choose
Special Functions under Functions in the main menu and then click Groups
Functions.
4. Choose the type of export from the Type of Export pop-up menu. The Export Using
Template page appears.
5. Click Template. The Templates for Exporting page appears.
6. Click the name of the template you want to edit. The Edit Export Template page
appears.
7. Edit the information as needed. For field descriptions, see How to Create an Export
Template.
8. Click Submit. The Templates for Exporting page appears. To continue modifying the
template, see How to Edit Template Columns.

How to Edit Template Columns
Note: The Export Using Template page is now also accessible via Start > System > Page
and Data Management > Export Using Template. Additionally, the Templates for
Exporting page is now also accessible via Start > System > Page and Data Management >
Templates for Exporting.
1. On the start page, search for and select a group of students. A list of students
appears in the Current Student Selection section. For more information, see Select a
Group of Students.
2. Click the [Select Function] arrow. The Group Functions pop-up menu appears.
3. Under Export, choose Export Using Template. The Export Using Template page
appears.
Note: Alternatively, if you have a current selection of students, you can choose
Special Functions under Functions in the main menu and then click Groups
Functions.
4. Choose the type of export from the Type of Export pop-up menu. The Export Using
Template page appears.
5. Click Template. The Templates for Exporting page appears.
6. Click the # Columns link of the template to be changed. The Edit Columns page
appears.
7. Click the Title of the column you want to edit. The Edit Column page appears.
Export
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8. Edit the information as needed. For field descriptions, see How to Add Template
Columns.
9. Click Submit. The Edit Columns page appears.

How to Delete a Template
Note: The Export Using Template page is now also accessible via Start > System > Page
and Data Management > Export Using Template. Additionally, the Templates for
Exporting page is now also accessible via Start > System > Page and Data Management >
Templates for Exporting.
1. On the start page, search for and select a group of students. A list of students
appears in the Current Student Selection section. For more information, see Select a
Group of Students.
2. Click the [Select Function] arrow. The Group Functions pop-up menu appears.
3. Under Export, choose Export Using Template. The Export Using Template page
appears.
Note: Alternatively, if you have a current selection of students, you can choose
Special Functions under Functions in the main menu and then click Groups
Functions.
4. Choose the type of export from the Type of Export pop-up menu. The Export Using
Template page appears.
5. Click Template. The Templates for Exporting page appears.
6. Click the name of the template you want to delete. The Edit Export Template page
appears.
7. Click Delete.
8. Click Confirm Delete. The Selection Deleted page appears.

How to Delete Template Columns
Note: The Export Using Template page is now also accessible via Start > System > Page
and Data Management > Export Using Template. Additionally, the Templates for
Exporting page is now also accessible via Start > System > Page and Data Management >
Templates for Exporting.
1. On the start page, search for and select a group of students. A list of students
appears in the Current Student Selection section. For more information, see Select a
Group of Students.
2. Click the [Select Function] arrow. The Group Functions pop-up menu appears.
Export
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3. Under Export, choose Export Using Template. The Export Using Template page
appears.
Note: Alternatively, if you have a current selection of students, you can choose
Special Functions under Functions in the main menu and then click Groups
Functions.
4. Choose the type of export from the Type of Export pop-up menu. The Export Using
Template page appears.
5. Click Template. The Templates for Exporting page appears.
6. Click the # Columns link of the template to be changed. The Edit Columns page
appears.
7. Click the Title of the column you want to delete. The Edit Column page appears.
8. Click Delete.
9. Click Confirm Delete. The Selection Deleted page appears.

How to Export Using a Template
Note: The Export Using Template page is now also accessible via Start > System > Page
and Data Management > Export Using Template.
1. On the start page, search for and select a group of students. A list of students
appears in the Current Student Selection section. For more information, see Select a
Group of Students.
2. Click the [Select Function] arrow. The Group Functions pop-up menu appears.
3. Under Export, choose Export Using Template. The Export Using Template page
appears.
Note: Alternatively, if you have a current selection of students, you can choose
Special Functions under Functions in the main menu and then click Groups
Functions.
4. Choose the type of export from the Type of Export pop-up menu. The Export Using
Template page appears.
5. Use the following table to enter information in the fields:
Field

Description

Type of Export

The type of data to export appears.
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Export template?

Choose the template to export from the pop-up menu.

For Which Records? The number of selected records appears.
6.
7.
8.
9.

Click Submit. The results of the export appear.
Choose File > Save As....
In the Save dialog, specify a name, location, and file type.
Click Save. Open the file using a spreadsheet or other application.

AutoSend Setup
Create AutoSend records to determine whether your PowerSchool system can
automatically create a copy of the information you specify at the selected date and time
intervals, and export the file to another system.
When creating an AutoSend record, you can determine the export parameters for each of
the following types of data:







Attendance
Course
Section
Student schedule
Student demographic
Teacher

How to Add an AutoSend Record
1. On the start page, choose System under Setup in the main menu. The System
Administrator page appears.
2. Under Data Management, click AutoSend Setup. The AutoSend Setup page
appears.
3. Click New. The AutoSend Record page appears.
4. Use the following table to enter information in the fields:
Field

Description

Name

Enter the name of this record.
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Use the pop-up menu to choose the data you want to send with
this record:

Data to Send








Attendance
Courses
Sections
Student Schedules
Students
Teachers

Note: Attendance table options are affected by the choice of
attendance recording methods. For more information, see
Attendance Preferences.

When to Execute

Use the pop-up menus to determine the hour and minutes at
which you want PowerSchool to automatically export a copy of
the data.
Note: If the minutes are 00, Autosend runs after the Hourly
Process has completed (not specifically on the hour stated but
within that hour).

Days to Execute

Enter the days of the week you want the system to export the
data. Starting with Monday, use the following abbreviations:
MTWHFSU.

Turn Execution Off

Select the checkbox to stop the system from automatically
exporting data. To turn AutoSend on, deselect the checkbox.
Indicate the method by which you want to export the records to
the other system from the pop-up menu.

Send Output to

To use a local (or network shared file system to export the
records to the other system:
1. Choose Local (or network shared) File System.
To use the file transfer protocol (FTP) to export the records to
the other system:
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1. Choose Ad Hoc FTP Server.
2. Enter information in the following fields:
 Use Passive Mode - If your FTP has difficulty
transferring, select the checkbox.
 FTP host name
 FTP account name
 FTP password
 Timeout in seconds - Indicates the number of
second that PowerSchool will try to make the
initial FTP connection with the remote system.
To use a managed connection, such as SFTP, to export the
records to the other system:
1. Choose Managed Connection. A second pop-up menu
appears.
2. Choose a managed connection from the pop-up menu.
Note: Managed Connections only appears in the pop-up
if configured and download capability is enabled. See
System > System Settings > Plugin Management >
Remote Connection Manager.

Path

Field Delimiter

If you do not use FTP to send the export file to another system,
enter the path and name of the file destination on your
PowerSchool server. If you use FTP to send the export file to
another system, enter the path and file name of the file
destination on the FTP server.
If this is on a single node, the path must be defined as being
from the root. If this is a server array, use only the file name and
never the path, since there is only one location for Autosend
files to be imported from on a server array. The file will be
exported in text format (.txt).
Use the pop-up menu to choose one of the following to
determine how values are separated in the export file:


Export
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Comma

Use the pop-up menu to choose how records are separated in
the export file:
Record Delimiter

Sort Order





CRLF: carriage return, line feed
CR: carriage return
LF: line feed

Enter the order that this record appears on the AutoSend Setup
page. If you do not make a choice, the order is alphabetical by
the name of the AutoSend record.

The system does not export the file if the number of records in it
First record of file is
does not match the number given in the first record of the file. It
"number_of_records="
is recommended that you select the checkbox.

Include "upload_type"

If you select the checkbox, the first or second record of the
export includes the text upload_type=, followed by the upload
type.
If you chose Attendance from the Data to Send pop-up menu,
select an option to indicate which attendance data you want the
system to include in the export file:

Attendance-Specific
Settings







Send any attendance modified in the last 24 hours
Send attendance modified since last upload
Send attendance data modified between these dates:
Enter the date range using the format mm/dd/yyyy or
mm-dd-yyyy. If you do not use this format, an alert
appears. If you submit the date with an incorrect format,
the date field is submitted as a blank entry.
Send all attendance to date

Otherwise, leave this field blank.
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Student-Specific
Settings

If you chose Students from the Data to Send pop-up menu, the
system includes all students currently enrolled at your school in
the export file.

E-Mail completion
report to

Enter the email addresses of the people you want the system to
send a completion report to each time it exports this file.
Separate multiple addresses with commas.
Choose the PowerSchool fields to include in this export file from
the pop-up menu.

Fields to export

Duplicate this
AutoSend record to all
schools on this server

Duplicate this
AutoSend record to
district office

Note: If you are adding database extension fields, enter the
extension field name using the format [extension
name].[fieldname].
If you are creating this record for the first time, you may want to
select the checkbox to make the record available to all schools
that use your PowerSchool system. Otherwise, deselect the
checkbox.
If you are creating this record for the first time, you may want to
select the checkbox to make the record available to the district
office. Otherwise, deselect the checkbox.
Note: This option is only for the Students or Teacher tables.

5. Click Submit. The AutoSend Setup page displays the new AutoSend record.

How to Edit an AutoSend Record
1. On the start page, choose System under Setup in the main menu. The System
Administrator page appears.
2. Under Data Management, click AutoSend Setup. The AutoSend Setup page
appears.
3. Click in the Name column the AutoSend record you want to edit. The AutoSend
Record page appears.
4. Edit the information as needed. For field descriptions, see How to Add an AutoSend
Record.
5. Click Submit. The AutoSend Setup page displays the edited AutoSend record.
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How to Delete an AutoSend Record
1. On the start page, choose System under Setup in the main menu. The System
Administrator page appears.
2. Under Data Management, click AutoSend Setup. The AutoSend Setup page
appears.
3. Click in the Name column the AutoSend record you want to delete. The AutoSend
Record page appears.
4. Click Delete.
5. Click Confirm Delete. The Selection Deleted page appears.

How to Manually Run an AutoSend Record
Manually run an AutoSend record to avoid waiting for the process to automatically run on
the specified day and time.
1. On the start page, choose System under Setup in the main menu. The System
Administrator page appears.
2. Under Data Management, click AutoSend Setup. The AutoSend Setup page
appears.
3. Click Run Now. The AutoSend record runs and displays the results.

Direct Database Export
Direct Database Access (DDA), also called Universal Search & Modify (USM), is one of the
most versatile functions of your PowerSchool system. Use DDA to search and match data in
all of the internal tables on your PowerSchool server.
Note: Depending on your security settings, you may not be able to perform all functions.
PowerSchool data is stored in a relational database of tables. Each table contains an
unlimited number of fields. When you use DDA, you directly access a table in the relational
database.
Use PowerSchool's Direct Database Export (DDE) page when you need to create an export
file or report that contains records from the tables. Use another application, such as a
spreadsheet application, to view or organize the records. Unlike using the Export Using
Template page, you can match and export data from two related tables.
You do not have to access DDA to export data from it. You can export DDA data while you
are signed in to PowerSchool. When you export data from DDA, the system creates an
independent export file that you can open or update using any application you want.
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For example, assume you want to export all ninth graders and their current grades to a
software application in which you can create a pie graph. Use the DDE function to match
the records in the student table to the current grades table; then, export both tables of
data, open the export file in a spreadsheet application, and create the graph.
Note: For detailed information about PowerTeacher Gradebook administration and setup,
see the Enable PowerTeacher for a Selection of Teachers section in the PowerTeacher
Gradebook Administrator Installation and Setup Guide available on PowerSource.

How to Select Records for Export-List View
View a list of all records in a selected table or search for specific records in a table. You can
also limit the export to records for all schools on your system or for just one school. For
example, export student data about California residents in fourth grade or above who
attend all schools on the system.
Note: The Direct Database Export (DDE) page is now also accessible via Start > System >
Page and Data Management > DDE.
1. On the start page, choose System under Setup in the main menu. The System
Administrator page appears.
2. Under Data Management, click Direct Database Export. The Direct Database
Export (DDE) page appears.
3. Use the following table to enter information in the fields:
Field

Description
Choose the table from which you want to export records from the
pop-up menu.

Current Table

Note: Database extension tables can be selected on the Current
Table pop-up. For more information, see Database Extensions in
the System Administrator User Guide available on PowerSource.
Note: See http://[your.school.address]/admin/home?ac=structure
for a complete list of PowerSchool tables and fields.

Select all [x] records
in this table

Export

To indicate the records to use in the export, do one of the
following:


Click Select all [number of] records in this table to select
all records and skip to Step 10.
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Identify search criteria in the Search Students fields by
continuing to the next step.
Note: Search for students either on the Search
Students page before beginning this procedure or
on the Direct Database Export page. Repeat steps 57 to use the second search field on the Direct
Database Export page, or repeat steps 5-9 to
narrow the search results even further.

Choose a field from the first pop-up menu.
Choose an operator from the second pop-up menu:

Search [Table
Name]










Equals (=)
Less than (<)
Greater than (>)
Less than or equal to (<=)
Greater than or equal to (>=)
Does not equal (#)
Contains (contains)
Does not contain (!Contain)

Enter the value for the field in the last field.
Search only in
records belonging to Select the checkbox to filter your school's records in the search.
[school name]
4. Click Search within the current [number of selected] records only. The Direct
Database Export (DDE) page displays the new number of current records in
selection.
5. Click List View to make sure you selected the records you want to export. The List
Records: [Table name] page appears with the fields separated by five periods.
Note: Click the field value to link to the Display Record page, which displays all fields
and their values for the selected record.
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How to Select Records for Export-Table View
View a report in a table format of all records in a selected table, or search for specific
records in a table. You can also limit the export to records for all schools on your system or
just one school. For example, export student data about California residents in fourth
grade or above who attend all schools on the system.
To modify the format of the table view, see How to Format the DDE Table View.
Note: The Direct Database Export (DDE) page is now also accessible via Start > System >
Page and Data Management > DDE.
1. On the start page, choose System under Setup in the main menu. The System
Administrator page appears.
2. Click Direct Database Export. The Direct Database Export (DDE) page appears.
3. Use the following table to enter information in the fields:
Field

Description
Choose the table from which you want to export records from the
pop-up menu.

Current Table

Note: Database extension tables can be selected on the Current
Table pop-up. For more information, see Database Extensions in
the System Administrator User Guide available on PowerSource.
Note: See http://[your.school.address]/admin/home?ac=structure
for a complete list of PowerSchool tables and fields.
To indicate the records to use in the export, do one of the
following:


Select all [x] records
in this table



Click Select all [number of] records in this table to select
all records and skip to Step 10.
Identify search criteria in the Search Students fields by
continuing to the next step.
Note: Search for students either on the Search
Students page before beginning this procedure or
on the Direct Database Export page. Repeat steps 57 to use the second search field on the Direct
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Database Export page, or repeat steps 5-9 to
narrow the search results even further.
Choose a field from the first pop-up menu.
Choose an operator from the second pop-up menu:

Search [Table
Name]










Equals (=)
Less than (<)
Greater than (>)
Less than or equal to (<=)
Greater than or equal to (>=)
Does not equal (#)
Contains (contains)
Does not contain (!Contain)

Enter the value for the field in the last field.
Search only in
records belonging to Select the checkbox to filter your school's records in the search.
[school name]
4. Click Search within the current [# of selected] records only. The Direct Database
Export (DDE) page displays the new number of current records in selection.
5. Click Table View to make sure you selected the records you want to export. The List
Records: [Table name] page appears with the records in a table format.
Note: Click the field value to link to the Modify Record page.

How to Format the DDE Table View
Note: The Direct Database Export (DDE) page is now also accessible via Start > System >
Page and Data Management > DDE.
1. On the start page, choose System under Setup in the main menu. The System
Administrator page appears.
2. Under Data Management, click Direct Database Export. The Direct Database
Export (DDE) page appears.
3. Click Table View Setup. The DDA/DDE Table View Setup page appears.
4. Use the following table to enter information in the fields:
Export
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Field

Description

Maximum Number
of Records Per Page

Enter the maximum number of records you want to appear on
each page of the table.

Maximum Number
of Fields Per Table

Enter the maximum number of fields you want the table to
display.

Maximum Number
of Character Per
Field

Enter the maximum number of characters each field in the table
can display.

Use Font Tag

Select the checkbox to apply font formats. Otherwise, deselect the
checkbox.

Format Data

Select the checkbox if you want the system to format the data
within the table. Otherwise, deselect the checkbox.

Use Gridlines

Select the checkbox if you want the table to separate each field of
data with gridlines. Otherwise, deselect the checkbox.

Alternate Colors

Select the checkbox if you want the table to display each row of
data in a different color. Otherwise, deselect the checkbox.

Use Cell Padding

Enter a number to indicate how much padding you want each cell
of the table to contain around the text. Most users enter a
number between 1 and 3.

5. Click Submit. The Direct Database Export (DDE) page appears.

How to Match Selections for Export
Match the records you searched for and selected in one table to records in another table to
gather and select information so you can view what you need. For example, match records
in the Students table to records in the CC (current grades) table.
Note: You cannot match tables that do not have a relationship or shared field. For
example, you cannot match the Students table to the Teachers table.
Export
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Note: The Direct Database Export (DDE) page is now also accessible via Start > System >
Page and Data Management > DDE.
1. On the start page, choose System under Setup in the main menu. The System
Administrator page appears.
2. Under Data Management, click Direct Database Export. The Direct Database
Export (DDE) page appears.
3. Choose one of the tables to match from the Current Table pop-up menu.
4. Click Select all [#] records in this table. The Direct Database Export (DDE) page
displays the new number of current records in selection.
5. Click Match Selection. The Match USM Selection page appears.
6. Choose the second table to match from the pop-up menu.
7. Click Proceed to match selection. The Direct Database Export page displays the
total number of records between the two matched tables that you can export. To
export the selected records, see How to Export Records.

How to Export Records
Before exporting records, you must first select the records using the Direct Database
Export function.
Note: The Direct Database Export (DDE) page is now also accessible via Start > System >
Page and Data Management > DDE.
1. On the start page, choose System under Setup in the main menu. The System
Administrator page appears.
2. Under Data Management, click Direct Database Export. The Direct Database
Export (DDE) page appears.
3. Select records for exporting. For more information, see How to Select Records for
Export-List View, How to Select Records for Export-Table View, or How to Match Selections
for Export.
4. Click Export Records. The Export Records page appears.
5. Use the following table to enter information in the fields:
Field

Description

Fields

Use the pop-up menu to choose the fields from which you want to
export a copy of the data. After you choose each field, the system
inserts the field name in the text box. Enter as many fields as
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needed. Only one field appears per line. Separate multiple fields
with a hard return.
To include fields from another table, manually enter the name of
the table in brackets, then the field name in the field box. For
example, to export fields from the Sections table and include
teachers' names, enter [teachers]lastfirst.
To include database extension fields from another table, manually
enter [Table.ExtensionName] in brackets, followed by the field
name. For example, to export fields from the Sections table and
include alternate course number, enter
[Courses.CoursesCoreFields]Alt_Course_Number.
A field delimiter separates fields (or "columns") in the exported
data. Use the pop-up menu to choose how you want the system
to separate each field in the export file:
Field Delimiter






Tab
Comma
None
Other: Enter the delimiter in the blank field.

A record delimiter separates records (or "rows") in the exported
data. Use the pop-up menu to choose how you want the system
to separate each record in the export file:
Record Delimiter






CR: Carriage return
CRLF: Carriage return and line feed
LF: Line feed
Other: Enter the delimiter in the blank field.

Surround Fields

Select the checkbox if you want the system to surround each field
with quotation marks in the export file. Otherwise, deselect the
checkbox.

Column titles on 1st
row

Select the checkbox if you want the first row of the export file to
have column titles indicating the fields included in each column.
Otherwise, deselect the checkbox.

Export

80J

Import and Export User Guide

Sorting Records

Determine the order of the records in the export file. Define a
primary, secondary, and tertiary sort. In the first field in the Sort
Field Name column, enter the field name by which you want to
primarily sort the records in the file. Then, select one of the
following to determine to sort records by this field in ascending or
descending order:



< (descending)
> (ascending)

6. Click Submit. For Mac users, the results of the export appear. For Windows users,
continue to the next step.
7. Choose File > Save As....
8. In the Save dialog, specify a name, location, and file type.
9. Click Save. Open the file using a spreadsheet or other application.
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Data Export Manager
Using the Data Export Manager, you can quickly and easily export data from PowerSchool
tables, database extensions, and PowerSchool data sets into a text file.

PowerSchool Tables
Individual access to most PowerSchool tables is provided through Data Export Manager.
Some tables have been removed for security reasons or because they are part of system
processes.

Database Extensions
Database extensions allow you to display customized information in PowerSchool. Access
to one-to-one, one-to-many, and independent database extensions is provide through Data
Export Manager. Database extensions may be created through the PowerSchool user
interface and define the table structure and related fields.







Database extension tables are listed in the Export From pop-up menu on the Data
Export Manager page using the name of the table.
Database extension table fields are available in the Data Export Manager when
selecting fields to export.
After choosing a database extension table, the database extension table fields
appear in a field list on the left side of the Data Export Manager page. The fields
appear in the following order:
 Each table lists its fields alphabetically after any primary and foreign keys.
 If the selected database extension table is a 1-to-1 or a 1-to-many extension
of a core table, the extension fields appear first, followed by the associated
parent table and any of its extensions.
 If the database extension table is an independent table that does not have a
parent table, its fields appear first, followed by any of its extension fields.
 A child table extension will list its fields and extensions first, followed by its
parent table fields and extensions.
Standard export options are available when exporting from a database extension
table.
Export results for an export from a database extension table are displayed in the
downloaded export file.

For more information, see Database Extensions.

Data Export Manager
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PowerSchool Data Sets
A PowerSchool data set is a data source that can be accessed via Data Export Manager, as
well as the API. A typical PowerSchool data set declares a set of arguments, a set of
columns, and a select statement. The arguments are optional, but the columns and select
statement are required. A PowerSchool data set is pre-defined by PowerSchool and
includes export modules for Course Archive, Incident, Student Email, Transportation, as
well as data sets for Students + Courses and others.

Additional Data Sets
Additional data sets, also available through Data Export Manager, provide more specific
access to data within PowerSchool. Additional data sets may be defined by PowerSchool or
by a third-party as a PowerQuery, and installed in PowerSchool via the Plugin Package.
Once the plugin is installed and enabled, the third-party data set becomes accessible as
another resource in PowerSchool.
Note: PowerQueries may be created for a specific function within PowerSchool and may
not necessarily be designed for use with the Data Export Manager. Consequently,
unexpected behaviors may occur when used outside of their primary context.

Set Page-Level Permissions
To ensure that only authorized staff members access the mass data export pages, set
page-level permissions for Start Page > Special Functions under Functions in the main
menu > Importing & Exporting > Data Export Manager under Exporting. For more
information about setting page-level permissions, see Security Permissions.

Export/Edit Settings
Using the Export/Edit tab on the Edit User Access Roles page, you can define which data
sources a user can export and/or edit. These access levels only apply to exporting,
previewing and editing via the Data Export Manager.
Note: For more information, see User Access Roles.

How to Define Export/Edit Settings
1. On the start page, choose System under Setup in the main menu. The System
Administrator page appears.
2. Under Security, click Roles Administration. The Roles Administration page appears.
3. Click User Access. The User Access Roles page appears.
Data Export Manager
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4. Click the name of the role you want to edit. The Edit User Access Role page appears.
5. Click the Export/Edit tab.
6. Use the following table to enter information in the Settings section:
Field

Description
Select the Export checkbox to permit users assigned to this role
to export content from any data source set to use the default
settings.

Default Access Level

Select the Edit checkbox to permit users assigned to this role to
edit content from any extensions set to use the default settings.
Note: The Edit checkbox only displays for database extensions
since the Data Export Manager only allows for editing of those
fields.

User can set up and
run scheduled
system templates

Select the checkbox to permit users assigned to this role to set up
and run scheduled templates.

7. Use the following table to enter information in the Filter section:
Note: Click the Filter arrow to collapse this section. Click the Filter arrow again to
expand this section.
Field

Description
The data source from which data is derived. To narrow the list of
data sources by data source name:

Data Source Name

Parent Name

1.
2.
3.
4.

Click the Add (+) button.
Choose Data Source Name from the first pop-up menu.
Enter the data source name or a portion of the name.
Click Apply.

To narrow the list of data sources by parent name:
1. Click the Add (+) button.
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2. Choose Parent Name from the first pop-up menu.
3. Enter the parent name or a portion of the name.
4. Click Apply.
Note: Parent column contents vary by data source type. For
extensions, it displays the name of the table that is extended. For
tables, it displays its own name. For data sets, it appears blank.
To narrow the list of data sources by data set type:

Type

1. Click the Add (+) button.
2. Choose Type from the first pop-up menu.
3. Choose one of the following from the second pop-up
menu:
 Table
 Data Set
 Extension
4. Click Apply.

To narrow the list of data sources by category:

Category

1. Click the Add (+) button.
2. Choose Category from the first pop-up menu.
3. Choose one of the following from the second pop-up
menu:
 [No Category]
 [Any of the functional-based categories]
4. Click Apply.

To modify this filter:

Use Defaults

Data Export Manager

1. Click the Add (+) button.
2. Choose Use Defaults from the first pop-up menu.
3. Choose one of the following from the second pop-up
menu:
 Choose Data Sources using the default setting.
 Choose Data Sources *not* using the default
setting.
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4. Click Apply.
Note: By default, this filter is set to Data Sources *not* using
the default setting.
To narrow the list of data sources by whether or not the Export
checkbox is selected:

Export

1. Click the Add (+) button.
2. Choose Export from the first pop-up menu.
3. Choose one of the following from the second pop-up
menu:
 True
 False
4. Click Apply.

To narrow the list of data sources by whether or not the Edit
checkbox is selected:
1. Click the Add (+) button.
2. Choose Edit from the first pop-up menu.
3. Choose one of the following from the second pop-up
menu:
 True
 False
4. Click Apply.

Edit

Note: To delete the filter, click the Minus (-) button next to the filter. To remove all
filter selections, click Clear.
8. Use the following table to view search results:
Note: Click the name of a column to sort by that column in ascending order. Click
again to sort in descending order.
Field

Description

Data Source Name

The data source name appears.
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If the data source is a PowerQuery, it appears as a link. Users
must have access to all required tables within the data set in
order for the data set to be available in the Data Export Manager.
1. Click the data set name to see its table dependency
information. The [Data Set] drawer opens.
2. Click Apply to grant this role access to the data set and all
tables listed. The [Data Set] drawer closes.

Parent Name

The parent name appears.

Type

The type appears.

Category

The category appears.
Do one of the following:


Use Defaults





Select the checkbox in the header row to select the Use
Defaults checkbox for all filtered data sources.
Deselect the checkbox in the header row to deselect the
Use Defaults checkbox for all filtered data sources.
Select the checkbox to use the role's default export and
edit settings for a data source.
Deselect the checkbox to use the data source specific
export and edit settings.

Do one of the following:


Export





Data Export Manager

Select the checkbox in the header row to permit exporting
of all filtered data sources.
Deselect the checkbox in the header row to prohibit
exporting of all filtered data sources.
Select the checkbox next to a specific data source to
explicitly permit exporting of the specific data source.
Deselect the checkbox next to a specific data source to
explicitly prohibit exporting of the specific data source.
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Do one of the following:




Edit



Select the checkbox in the header row to permit editing of
all filtered data sources.
Deselect the checkbox in the header row to prohibit editing
of all filtered data sources.
Select the checkbox next to a specific data source to
explicitly permit editing of the specific data source.
Deselect the checkbox next to a specific data source to
explicitly prohibit editing of the specific data source.

Note: If this checkbox next to a specific data source is
selected/deselect, the Export checkbox is automatically
selected/deselected as well.
Note: This checkbox only applies to editing extensions.
[Pagination]

Use to navigate the search results.

Rows/Page

By default, ten records display per page. To view more records per
page, enter the appropriate number in the field.

9. Click Save. A confirmation message appears.
Note: Changes are also saved for fields that may no longer be visible with the
current filter.

How to View Data Export Manager Information for Assigned Roles
1. On the start page, search for and select a staff member. For more information, see
Staff Search.
2. On the Staff page, click Security Settings from the staff pages menu. The Security
Settings page appears.
3. Click the Admin Access and Roles tab.
4. Click the [Information Icon] next to the role for which you want to view Data Export
Manager information. Data Export Manager information appears, including the
default level followed by the data sources users assigned to this role can edit and/or
export.
5. When done viewing, click OK to close the pop-up.
Data Export Manager
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Export Data Using the Data Export Manager
This procedure may be performed for a selected school or at the district level. This
procedure may be performed for a student selection or teacher selection depending on
your Export From selection. For more information about selecting students, see Student
Search. For more information about selecting staff, see Staff Search.
Note: The Data Export Manager page is also accessible via Start > System > Page and
Data Management > Data Export Manager.

How to Export Data Using the Data Export Manager
1. On the start page, choose Special Functions under Functions in the main menu.
The Special Functions page appears.
2. Click Importing & Exporting. The Importing & Exporting page appears.
3. Under Data Export, click Data Export Manager. The Data Export Manager page
appears.
Note: The Export tab appears selected by default.
4. Use the following table to enter information in the Select Columns to Export section:
Note: Information display based on your security permissions.
Field

Description
Choose the category that contains the data you want to export
from the pop-up menu:


Category







Data Export Manager

Tables displays top 20 PowerSchool tables followed by
most other PowerSchool tables.
Database Extensions displays database extensions.
PowerSchool Data Sets displays approved data sets and
any preexisting or new export modules.
Additional Data Sets displays all other data sets and thirdparty PowerQueries.
Show All displays all of the above.
[Functional Categories], displays any functional
categories within PowerSchool that have display names,
such as Attendance, Grading, or Scheduling.
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[Uncategorized] displays any functional categories within
PowerSchool that do not have display names.

Choose the data source that contains the data you want to export
from the pop-up menu.
Note: Only data sources for which you have export access to all
required tables and fields will be available for selection. If a data
set appears shaded and cannot be selected, you do not have field
level access to one or more fields used in that data set.
Note: Descriptions have been defined for many of the mass data
modules and can be further customized to provide more detailed
instructions. To view a list of descriptions:

Export From

1. On the start page, choose System under Setup in the main
menu. The System Administrator page appears.
2. Under Data Management, click Page and Data
Management. The Page and Data Management page
appears.
3. Under Localization, click Localize PowerSchool. The
Localize PowerSchool page appears.
4. Click the Data tab.
5. Choose PowerSchool Customer Defined Data from the
Choose the functional area or item you want to
translate pop-up menu.
6. Choose Mass Data Module from the Category pop-up.
7. Click Retrieve Text. Descriptions for the mass data
module appear in the Text for translation section.
For more information, see Localize Using Batch Mode.
If the data set contains more than one table or other entity, this
checkbox appears. Do one of the following:

Select All

Data Export Manager



To export all fields from all tables or entities within the
data set, select the checkbox. Note all the checkboxes
appear selected.
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To remove all fields from all tables or entities within the
data set, deselect the checkbox. Note all the checkboxes
appear deselected.

After choosing the data source, the available fields appear in a
field list on the left side of the page.
Note: Click the arrow to collapse a section. Click the arrow again
to expand a section.
Do one of the following:


[Data Source]






To export all fields within a section, select the checkbox by
the table or section name. Note all the checkboxes appear
selected.
To remove all fields within a section, deselect checkbox by
the table or section name. Note all the checkboxes appear
deselected.
To export only certain fields within the data set, select the
field checkboxes.
To remove a field, deselect the checkbox next to the
appropriate field.

Note: You can also remove a field by clicking the minus ( - ) button
that appears on the right side of the page next to the field.
If the data set contains only one table or entity, the selected fields
are sorted based on the order that the fields were selected. To
modify the order of fields, use the up and down arrows to move
fields.
Sort

Field

Data Export Manager

If the data set contains more than one table or entity, the selected
fields are sorted based on the hierarchy of the parent, child, and
sibling fields that were selected. Note the title above entity
groupings. To modify the order of fields, use the up and down
arrows to move fields. Fields within an entity can only be sorted
within that entity. As such, some up and down arrows may be
disabled to prevent invalid sorting.
The internal PowerSchool field name as it appears in the data set.
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Label Used on
Export

Remove

Enter the name you want to appear for the field in the export file.
Note: This field is populated with the field name from the data
set. This field cannot be left blank.
Click to remove a field.

5. Click Next.
6. Use the following tables to review information in the Select Records to Export from
[Data Source] section:
Note: Information displays based on your security permissions.
Field

Description
Click the arrow to expand this section. Click the arrow again to
collapse this section.
To narrow the list:

Built In Filters

1. Enter information as needed.
2. Click Apply. The page refreshes and display filtered results.
Note: To remove all filter selections, click Clear.
Note: This section displays based on your Export From selection.
If this section does not appear, there are no built in filters for your
selection.
Click the arrow to expand this section. Click the arrow again to
collapse this section.
To narrow the list:

Column Filters

Data Export Manager

1. Choose the column by which you want to filter records
from the Filter by pop-up menu.
2. Select a comparator from the Value pop-up menu.
3. Enter search criteria in the Value field.
4. To add another filter, click + and repeat Step 1.
5. To delete a filter, click - next the filter.
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6. Optionally, click Show Records. The page refreshes and
display filtered results.
Note: To remove all filter selections, click Clear.
Note: This section displays based on your selected data set. If this
section does not appear, there are no column filters for the data
set.
Note: Some fields in your selected data set may not be available
for filtering.
Select one of the following options:
[Export Rows]




Export All Rows to apply any Built In Filters.
Export Filtered Rows to apply Built In Filters and Column
Filters.

It is extremely important to note that you are making a
permanent mass-change to data in the database when you use
this feature.

Edit All Filtered
Records

1. Click Show Records in order for this button to appear.
2. Click to edit field data for multiple records. The Edit drawer
appears.
3. To narrow the list, enter search criteria in the Filter field.
4. Select the field option and then enter data.
5. Click Submit. The Edit closes.
Note: Only extensions from the originally selected database
extension are editable.
Note: This button does not appear if you have read-only access to
the page.

Actions

Data Export Manager

1. Click the Edit icon to update field data. The Edit drawer
appears.
2. Edit information at needed.
3. Click Submit. The Edit closes.
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Note: Only extensions from the originally selected database
extension are editable.
Note: This column does not appear if you have read-only access
to the page.
Fields to be exported.
[Data Source]

Note: Click column headings to sort in ascending order. Click
again to sort in descending order.

7. Click Next.
8. Use the following table to enter information in the Export Summary and Output
Options fields:
Note: Information display based on your security permissions.
Field

Description
The number of records to be exported appears.

Export Summary |
Records to Export

Note: This number may differ from the record selection when the
selected data set is from extended tables. If exporting from a
standalone extended table, the total number of records displays
regardless of students/teachers selection. If exporting from a 1-to1 or 1-to-many extended table, the number of records that display
depends on whether current student/teacher selection or all
active students/teachers were selected.
Enter the name of the export file.
Note: Default is set to [selected data source]_export.txt.

Export Format |
Export File Name

Export Format |
Line Delimiter

Note: Special characters in file names may not display properly
depending on your operating system. For example, characters
considered reserved by your operating system or file names with
leading or trailing periods.
Use the pop-up menu to choose which delimiter to use to
separate the lines of data in the export file:


Data Export Manager

CR: Carriage return (default)
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CRLF: Carriage return/line feed
LF: Line feed
Other: If selected, enter the type of end-of-line delimiter in
the adjacent field, such as a semicolon.

Note: Only one character may be entered. A double quote
character is not allowed.
Use the pop-up menu to choose which delimiter to use to
separate the fields in the export file:

Export Format |
Field Delimiter





Tab (default)
Comma
Other: If selected, enter the field delimiter in the adjacent
field.

Note: Only one character may be entered. A double quote
character is not allowed.
Use the pop-up menu to choose the character set for the export
file. This selection is specific to the operating system where the
import file was created:
Export Format |
Character Set






Windows ANSI (Windows)
Mac Roman (Mac)
ISO 8859-1
UTF-8

Note: Defaults to the appropriate character set based on the
client operating system.
Do one of the following:
Export Options |
Include Column
Header




Select the checkbox if you want a header row to appear in
the export file.
Deselect the checkbox if you do not want a header row to
appear in the export file.

Note: By default, the checkbox is selected.

Data Export Manager
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Note: Column headers are defined using the Label field in the
Select Columns to Export section.
Do one of the following:


Export Options |
Surround "Field
Values" in Quotes



Select the checkbox if you want the exported field values to
appear with quotes around them in the export file.
Deselect the checkbox if you do not want the exported
field values to appear with quotes around them in the
export file.

Note: By default, the checkbox is not selected.
9. Use the following table to do one of the following:
Field

Description
Click Export. Save and/or download the export file to your
desktop (varies depending on your browser).

Export

Note: If using Excel to view an export file that includes fields
containing characters that are being used as a record delimiter,
content may not be parsed correctly. It is recommended that you
use a text editor to view the export file.

Save Template

For detailed information, see Step 5 of How to Create a Template.

Managing My Templates
If you export the same data frequently, you can create a template so that you don't have to
define the fields, filters and Export Options used every time you perform an export. Once
you create a template, the template appears on the My Templates tab. From the My
Templates tab, you can easily manage your templates.
Note: Your templates are unique to your account and can be used at any school that you
can switch to.

Data Export Manager
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Note: Exports are always run within your current school context. Be careful when saving
School ID filters as part of a template as this will prevent the export from exporting data at
other schools.

How to Create a Template
Note: Student and staff selections are not saved with a template. If a specific set of student
or staff is required for an export, use the column filters.
1. On the start page, choose Special Functions under Functions in the main menu.
The Special Functions page appears.
2. Click Importing & Exporting. The Importing & Exporting page appears.
3. Under Data Export, click Data Export Manager. The Data Export Manager page
appears.
4. Prepare the export as needed. All selected Fields, Filters, and Export Options will be
saved with the template. For detailed information, see How to Export Data Using the
Data Export Manager.
5. Click Save Template. The Save Export Template pop-up appears.
6. Enter the template name in the Name field.
7. Enter a description in the Description field.
8. Note the mapped fields that are included in the template.
9. Click Save as New. A confirmation message appears.

How to View Templates
1. On the start page, choose Special Functions under Functions in the main menu.
The Special Functions page appears.
2. Click Importing & Exporting. The Importing & Exporting page appears.
3. Under Data Export, click Data Export Manager. The Data Export Manager page
appears.
4. Click the My Templates tab. The My Templates tab displays the following
information for each template:
Note: Click column headings to sort templates in ascending order. Click again to
sort in descending order.
5. Use the following table to do one of the following:

Data Export Manager
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Field

Description

Template

The name of the template. Click to load for export or editing.

Description

The description for the template.

Data Source

The data source from which the template is derived.
The actions that may be taken with the template.

Actions

Use the Schedule icon to schedule the template for export. For
more information, see How to Schedule an Export.
Use the Delete icon to delete the template. For more information,
see How to Delete a Template.

How to Apply a Template
Note: Current student and staff selections are not saved with a template. If a specific set of
student or staff is required for an export, use the column filters.
1. On the start page, choose Special Functions under Functions in the main menu.
The Special Functions page appears.
2. Click Importing & Exporting. The Importing & Exporting page appears.
3. Under Data Export, click Data Export Manager. The Data Export Manager page
appears.
4. Click the My Templates tab. The My Templates tab appears.
Note: Click column headings to sort templates in ascending order. Click again to
sort in descending order.
5. Click the name of the template you want to apply. The Export tab appears.
6. To continue, see Step 4 of How to Export Data Using the Data Export Manager.

How to Create a Template from an Existing Template
Note: Student and staff selections are not saved with a template. If a specific set of student
or staff is required for an export, use the column filters.

Data Export Manager
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1. On the start page, choose Special Functions under Functions in the main menu.
The Special Functions page appears.
2. Click Importing & Exporting. The Importing & Exporting page appears.
3. Under Data Export, click Data Export Manager. The Data Export Manager page
appears.
4. Click the My Templates tab. The My Templates tab appears.
Note: Click column headings to sort templates in ascending order. Click again to
sort in descending order.
5. Click the name of the template you want to use to create a new template. The
Export tab appears.
6. Prepare the export as needed. For detailed information, see How to Export Data
Using the Data Export Manager.
7. Click Save Template. The Save Export Template pop-up appears.
8. Enter the template name in the Name field.
9. Enter a description in the Description field.
10. Click Save as New. A confirmation message appears.

How to Edit a Template
Note: Student and staff selections are not saved with a template. If a specific set of student
or staff is required for an export, use the column filters.
1. On the start page, choose Special Functions under Functions in the main menu.
The Special Functions page appears.
2. Click Importing & Exporting. The Importing & Exporting page appears.
3. Under Data Export, click Data Export Manager. The Data Export Manager page
appears.
4. Click the My Templates tab. The My Templates tab appears.
Note: Click column headings to sort templates in ascending order. Click again to
sort in descending order.
5. Click the name of the template you want to edit. The Export tab appears.
6. Prepare the export as needed. For detailed information, see How to Export Data
Using the Data Export Manager.
7. Click Save Template. The Save Export Template pop-up appears.
8. Click Save. A confirmation message appears.

Data Export Manager
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How to Delete a Template
1. On the start page, choose Special Functions under Functions in the main menu.
The Special Functions page appears.
2. Click Importing & Exporting. The Importing & Exporting page appears.
3. Under Data Export, click Data Export Manager. The Data Export Manager page
appears.
4. Click the My Templates tab. The My Templates tab appears.
Note: Click column headings to sort templates in ascending order. Click again to
sort in descending order.
5. Click the Delete icon next to the template you want to delete.
6. Click the Confirm Delete icon. A confirmation message appears.

Managing Scheduled System Templates
Once a template is scheduled for export, it becomes a system template and is available for
exporting data associated only within the school context it is created. System templates
created at the district office will export data from all schools.
Data exported from System Templates do not have field level security restrictions.
However, users who are permitted to set up and run scheduled system templates do not
necessarily have access to the export destination. Security of the export destination is
managed by its own security mechanisms, outside of PowerSchool.

How to Schedule a Template for Export
1. On the start page, choose Special Functions under Functions in the main menu.
The Special Functions page appears.
2. Click Importing & Exporting. The Importing & Exporting page appears.
3. Under Data Export, click Data Export Manager. The Data Export Manager page
appears.
4. Click the My Templates tab. The My Templates tab appears.
Note: Click column headings to sort templates in ascending order. Click again to
sort in descending order.
5. Click the Schedule Template icon next to the template you want to schedule for
export. The Set Schedule drawer appears.

Data Export Manager
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Note: This button only appears for users with a role permitted to edit scheduled
system templates.
6. Use the following tables to enter information in the fields:
Field

Description

Schedule Active

By default, this checkbox is selected indicating PowerSchool is
scheduled to automatically export a copy of the data. If you do not
want PowerSchool to automatically export a copy of the data,
deselect the checkbox.
Select the checkbox next to each day of the week you want
PowerSchool to automatically export a copy of the data:

Days to Execute

When to Execute









Mon
Tues
Wed
Thu
Fri
Sat
Sun

Enter the hour and minutes you want PowerSchool to
automatically export a copy of the data.
Choose the method by which you want to export a copy of the
data from the pop-up menu:

Send Output To




PowerSchool Folder
SFTP

Note: For more information about SFTP, see Remote Connection
Management.
Path

Data Export Manager

Enter the path where you want the exported file saved.
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A relative path may be entered, such as /folder/subfolder. In
which case, the file will be written to the given path relative to the
PowerSchool data folder as defined by the PowerSchool Installer.
An absolute path preceded by drive letter may also be entered,
such as F:\exportdirectory\. Absolute paths may only refer to local
drives in a single node environment or to network drives as
defined by the PowerSchool Installer for multi-node
environments.

Email Completion
Report To

Enter the email addresses of the people you want to send a
completion report to each time it exports this file. Separate
multiple addresses with commas.

7. Click Save. A confirmation message appears. The scheduled template now appears
on the Scheduled System Templates tab.

How to View Scheduled System Templates
1. On the start page, choose Special Functions under Functions in the main menu.
The Special Functions page appears.
2. Click Importing & Exporting. The Importing & Exporting page appears.
3. Under Data Export, click Data Export Manager. The Data Export Manager page
appears.
4. Click the Scheduled System Templates tab. The Scheduled System Templates tab
appears.
5. Use the following tables to view information in the fields:
Field

Template

Data Source

Data Export Manager

Description
The name of the template scheduled for export. Click to load for
export or editing.
Note: When template is scheduled, the name of the template is
appended with (copy).
The data source from which the template is derived.
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Status

Indicates whether or not the scheduled export is set active. For
more information, see Schedule Active.
Indicates one of the following:

Last Run





The date and time the scheduled export completed.
The date and time the scheduled export failed.
The date and time the scheduled export began running.

The actions that may be taken with the scheduled export.
Use the Edit icon to edit scheduled export options. For more
information, see How to Edit System Template Schedule Options.
Actions

Use the Run Now icon to run the scheduled export immediately.
For more information, see How to Run a Scheduled System
Template.
Use the Delete icon to delete a scheduled export. For more
information, see How to Delete a Scheduled System Template.

How to View Scheduled System Template Results
Once a scheduled export runs, navigate to where the exported file was saved (designated
path) to view scheduled export results.

How to Edit System Template Schedule Options
1. On the start page, choose Special Functions under Functions in the main menu.
The Special Functions page appears.
2. Click Importing & Exporting. The Importing & Exporting page appears.
3. Under Data Export, click Data Export Manager. The Data Export Manager page
appears.
4. Click the Scheduled System Templates tab. The Scheduled System Templates tab
appears.
Note: Click column headings to sort templates in ascending order. Click again to
sort in descending order.

Data Export Manager
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5. Click the Edit icon next to the template you want to edit. The Set Schedule drawer
appears.
6. Edit as needed. For field descriptions, see How to Schedule an Export.
7. Click Save. A confirmation message appears.

How to Run a Scheduled System Template Immediately
1. On the start page, choose Special Functions under Functions in the main menu.
The Special Functions page appears.
2. Click Importing & Exporting. The Importing & Exporting page appears.
3. Under Data Export, click Data Export Manager. The Data Export Manager page
appears.
4. Click the Scheduled System Templates tab. The Scheduled System Templates tab
appears.
Note: Click column headings to sort templates in ascending order. Click again to
sort in descending order.
5. Click the Run Now icon next to the template you want to run. A confirmation
message appears.
6. Navigate to where the exported file was saved (designated path) to view scheduled
export results.

How to Delete a Scheduled System Template
1. On the start page, choose Special Functions under Functions in the main menu.
The Special Functions page appears.
2. Click Importing & Exporting. The Importing & Exporting page appears.
3. Under Data Export, click Data Export Manager. The Data Export Manager page
appears.
4. Click the Scheduled System Templates tab. The Scheduled System Templates tab
appears.
Note: Click column headings to sort templates in ascending order. Click again to
sort in descending order.
5. Click the Delete icon next to the template you want to delete.
6. Click the Confirm Delete icon. A confirmation message appears.
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Import and Export Standards
Using the PowerSchool import and export feature, you can manage standards more
efficiently for your district.
There are three areas in which you can import and export standards into or out of
PowerSchool. Each area provides specific information for managing standards.




Standards: District List for importing and exporting general information and
associations for standards.
Standards: Course Weight for importing and exporting course weights for a parent
standard or lower level standard.
Standards: Final Grade By Class for importing and exporting standards final grades.

You can import your standards into PowerSchool and make them available for teachers to
use in PowerTeacher Pro.
The Data Import Manager page is accessible via Start > System > Page and Data
Management > Data Import Manager. You must have the correct security permissions
and user roles in order to use this feature.

Standards: District List
Use the Standards: District List to mass update general standards information, such as the
identifier, conversion scale, grade scale, or parent identifier.

How to Export Standards: District List
When updating standards, you can either use the Standards ID or the identifier and year.
You can obtain the ID for each standard by exporting the Standards: District List first. You
can use the export to add or change data and import it back in to PowerSchool.
1. On the start page, choose Special Functions under Functions in the main menu.
The Special Functions page appears.
2. Click Importing & Exporting. The Importing & Exporting page appears.
3. Under Data Export, click Data Export Manager. The Data Export Manager page
appears.
4. Select PowerSchool Data Sets from the Category pop-up menu.
5. Select Standards: District List from the Export From pop-up menu. The Standards:
District List available fields appear in a field list on the left side of the page.
6. Select the fields you want to export.
Import and Export Standards
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If you want to export the data to make changes and then import it back in to
PowerSchool, select the ID field, as this may make the import a bit faster
than using the identifier and year. If the ID, Identifier and Year are all in the
import file, the import process will key off of the ID.
 If you want to use this export to create new grade scales and import them
into PowerSchool to be used by PowerTeacher Pro, the following fields are
required in the file:
 ID
 Name
 GradescaleItemDCID
 ConversionScaleID
 YearID
7. Change the sort order and labels for the export as needed.
8. Click Next. The Select Columns to Export page appears.
9. Set the filter criteria, and then click Show Records. The data appears on the page.
10. Click the Pencil icon next to the record you want to edit. The Edit drawer appears.
11. Enter the changes for the record, and click Submit to close the Edit drawer.
12. Click Next on the Data Export Manager page.
13. Select the export output options, and then click Export.


How to Import Standards: District List
You can make additional changes as needed to the file prior to importing back in to
PowerSchool.
1. On the start page, choose Special Functions under Functions in the main menu.
The Special Functions page appears.
2. Click Importing & Exporting. The Importing & Exporting page appears.
3. Click Data Import Manager. The Data Import Manager page appears.
4. Select the source file for the import.
5. Select Standards: District List from the Import Into pop-up menu, and then select
the Field Delimiter for the file.
6. Click Next.
7. Select the PowerSchool Field to map the information from the import file from the
pop-up menu.
8. Click Next.
9. Select the import options for the file.
Note: The Longitudinal ID is a number used to link a standard from year to year. If
you do not specify the Longitudinal ID in the import file, you have the option of

Import and Export Standards
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retrieving the ID of the matching identifier from a previous year, or creating a new
value.
10. Click Import.

Standards: Course Weights
To import course weights, you must have standards already created and associated to
courses in PowerSchool.
In the Standards: Course Weights dataset, the Parent Weight is used when calculating a
final traditional grade. Modifying this weight will impact final traditional grades.
Child Weight is rolled up to the Parent Weight in final standards grades.

How to Export Standards: Course Weights
You can export the Standards: Course Weights data set, make any necessary changes, and
import the updated dataset back in to PowerSchool.
1. On the start page, choose Special Functions under Functions in the main menu.
The Special Functions page appears.
2. Click Importing & Exporting. The Importing & Exporting page appears.
3. Under Data Export, click Data Export Manager. The Data Export Manager page
appears.
4. Select PowerSchool Data Sets from the Category pop-up menu.
5. Select Standards: Course Weights from the Export From pop-up menu. The
Standards: Course Weights available fields appear in a field list on the left side of the
page.
6. Select the fields you want to export.
 If you want to make changes to this dataset and import it back in to
PowerSchool, the YearID field is required in the data import file when
creating new course weights via import. Additionally, you can include a
combination of the following fields in the import file:
 ParentCourse
 ParentStandardID
 StandardCourceAssocID
7. Change the sort order and labels for the export as needed. You can only filter on
certain Parent record fields.
8. Click Next. The Select Columns to Export page appears.
9. Set the filter criteria, and then click Show Records. The data appears on the page.
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10. Click the Pencil icon next to the record you want to edit. The Edit drawer appears.
You can only edit Parent weights using this feature.
11. Enter the changes for the record, and then click Submit to close the Edit drawer.
12. Click Next on the Data Export Manager page.
13. Select the export output options, and then click Export.

How to Import Standards: Course Weights
You can make additional changes as needed to the file prior to importing back in to
PowerSchool.
1. On the start page, choose Special Functions under Functions in the main menu.
The Special Functions page appears.
2. Click Importing & Exporting. The Importing & Exporting page appears.
3. Click Data Import Manager. The Data Import Manager page appears.
4. Select the source file for the import.
5. Select Standards: Course Weights from the Import Into pop-up menu, and select
the Field Delimiter for the file.
6. Click Next.
7. Select the PowerSchool Field to map the information from the import file from the
pop-up menu.
8. Click Next.
9. Select the import options for the file.
10. Click Import.

Standards: Final Grades By Class
Export a list of all standards final grades. This export allows you to choose if you want to
use the current student selection to export final grades for a selection of students.

How to Export Standards: Final Grades By Class
1. On the start page, choose Special Functions under Functions in the main menu.
The Special Functions page appears.
2. Click Importing & Exporting. The Importing & Exporting page appears.
3. Under Data Export, click Data Export Manager. The Data Export Manager page
appears.
4. Select PowerSchool Data Sets from the Category pop-up menu.
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5. Select Standards: Final Grades By Class from the Export From pop-up menu. The
Standards: Final Grades By Class available fields appear in a field list on the left side
of the page.
6. Select the fields you want to export.
7. Change the sort order and labels for the export as needed.
8. Click Next. The Select Columns to Export page appears.
9. Select the Use current student selection checkbox to use your current student
selection for the export. Select the Year to include from the pop-up menu.
Additionally, you can filter on Standard Identifiers, Course Numbers, and
StoreCodes. The export will only export standards grades for the schools for which
you have security permissions enabled.
10. Click Next.
11. Select the export output options, and click Export.

How to Import Standards: Final Grades By Class
You can make changes as needed to the file prior to importing back in to PowerSchool.
1. O the start page, choose Special Functions under Functions in the main menu. The
Special Functions page appears.
2. Click Importing & Exporting. The Importing & Exporting page appears.
3. Click Data Import Manager. The Data Import Manager page appears.
4. Select the source file for the import.
5. Select Standards: Final Grades By Class from the Import Into pop-up menu, and
select the Field Delimiter for the file.
6. Click Next.
7. Select the PowerSchool Field to map the information from the import file from the
pop-up menu.
8. Click Next.
9. Select the import options for the file.
10. Click Import.

Import and Export Standards

109J

